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Front panel and accessories comparisons

The following tables provide information about the HP Scanjet 4400c 
series and 5400c series scanners, including descriptions of the buttons 
available on the front panels and the accessories you can use with 
these scanners.
To find information about your scanner, see the following tables:

"HP Scanjet 4400c" on page 4.
"HP Scanjet 4470c" on page 5.
"HP Scanjet 5400c" on page 6.
"HP Scanjet 5470c" on page 8.
"HP Scanjet 5490c" on page 10.
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HP Scanjet 4400c

Feature Included on scanner 
or in box

Supported 
accessorya

a. Supported accessories include accessories that are not boxed with the
scanner, but can be purchased separately.

Copy button

Photo Reprint button

Scan To button

E-mail button

Power Save button

USB cable

HP Scanjet Transparency Adapter 
(XPA)
Download from Www.Somanuals.com. All Manuals Search And Download.
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HP Scanjet 4470c

Feature Included on scanner 
or in box

Supported 
accessorya

Copy button

Color/black & white copy and
select number of copies buttons

Photo Reprint button

Scan To button

E-mail button

Share-to-Web button

Power Save button

More Options button

Cancel button

Two-digit LCD

USB cable

HP Scanjet Transparency Adapter 
(XPA)

a. Supported accessories include accessories that are not boxed with the
scanner, but can be purchased separately.

Feature Included on scanner 
or in box

Supported 
accessorya
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HP Scanjet 5400c

Feature Included on scanner 
or in box

Supported 
accessorya

Copy button

Color/black & white copy and
select number of copies buttons

Photo Reprint button

Scan To button

E-mail button

Share-to-Web button

Power Save button

More Options button

Cancel button

Two-digit LCD

Scanner lock

USB cable

Parallel cableb

Feature Included on scanner 
or in box

Supported 
accessorya
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HP Scanjet Transparency Adapter 
(XPA)

HP Scanjet Automatic Document 
Feeder (ADF)

a. Supported accessories include accessories that are not boxed with the
scanner, but can be purchased separately.

b. The parallel cable shipped with the scanner is for computers that use
Microsoft Windows. For Macintosh computers, use the USB cable. For
more information, see the Setup and Support Guide.

Feature Included on scanner 
or in box

Supported 
accessorya
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HP Scanjet 5470c

Feature Included on scanner 
or in box

Supported 
accessorya

Copy button

Color/black & white copy and
select number of copies buttons

Photo Reprint button

Scan To button 
(with Speed Destinationsb)

Select Destination button

E-mail button

Share-to-Web button

Power Save button

More Options button

Cancel button

16-character LCD

Scanner lock

USB cable

Feature Included on scanner 
or in box

Supported 
accessorya
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Parallel cablec

HP Scanjet Transparency Adapter 
(XPA)

HP Scanjet Automatic Document 
Feeder (ADF)

a. Supported accessories include accessories that are not boxed with the
scanner, but can be purchased separately.

b. Speed Destinations are scanner button options available in the HP
Scanjet Controls control panel. See "Changing settings for Speed
Destinations (some models only)" on page 36.

c. The parallel cable shipped with the scanner is for computers that use
Microsoft Windows. For Macintosh computers, use the USB cable. For
more information, see the Setup and Support Guide.

Feature Included on scanner 
or in box

Supported 
accessorya
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HP Scanjet 5490c

Feature Included on scanner 
or in box

Supported 
accessorya

Copy button

Color/black & white copy and
select number of copies buttons

Photo Reprint button

Scan To button 
(with Speed Destinationsb)

Select Destination button

E-mail button

Share-to-Web button

Power Save button

More Options button

Cancel button

16-character LCD

Scanner lock

USB cable

Feature Included on scanner 
or in box

Supported 
accessorya
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Parallel cablec

HP Scanjet Transparency Adapter 
(XPA)

HP Scanjet Automatic Document 
Feeder (ADF)

a. Supported accessories include accessories that are not boxed with the
scanner, but can be purchased separately.

b. Speed Destinations are scanner button options available in the HP
Scanjet Controls control panel. See "Changing settings for Speed
Destinations (some models only)" on page 36.

c. The parallel cable shipped with the scanner is for computers that use
Microsoft Windows. For Macintosh computers, use the USB cable. For
more information, see the Setup and Support Guide.

Feature Included on scanner 
or in box

Supported 
accessorya
Download from Www.Somanuals.com. All Manuals Search And Download.
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1 Getting started

This section contains the basics to help you get started with your new 
HP Scanjet scanner. From here, you can learn about viewing the 
product tour, preparing items before you scan them, and choosing 
which scanning method to use.

Printing this information 

To print this PDF manual, use the Print command on the File menu. 
Print the whole document, or print only the chapters or topics you want 
according to their page numbers. See the table of contents for page 
numbers of topics.

Viewing the product tour

The product tour is a fast and easy way to explore the capabilities of 
the scanner and see some interesting ways you can use the scanner 
to meet your needs. The product tour, which only takes three minutes, 
begins automatically when you start the HP Precisionscan Pro 
software for the first time. 
To view the tour at other times: In the HP Scanning Software folder, 
double-click Product Tour. 
Download from Www.Somanuals.com. All Manuals Search And Download.
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Where do I start?

You can start scanning from one of these places:

l Scanner buttons

l HP Precisionscan Pro software 

l Another program 

l HP Scanjet Copy Utility 

Where you start depends on what you want to do with the scan and on 
your own preferences.

Using the scanner buttons

Use the scanner buttons, which are shortcuts, when:

l You want to start at the scanner.

l You want to scan quickly without making changes.

l You want to scan an item using the default settings optimized for 
the destination you choose.

See "Scanning from scanner buttons" on page 25.

Using the HP Precisionscan Pro software

Use the HP Precisionscan Pro software when:

l You want to view or change a scanned image before you send it. 
Changes might include resolution, cropping, or resizing.

l You want to send to a destination, such as a desktop publishing 
program, but there is no button on the scanner for that destination.

See "Scanning from HP Precisionscan Pro" on page 39.

Using another program

Start scanning from within another program when:

l You want to bring a scanned item into an open program, such as 
your word-processing program.

l The program in which you are working is compliant with TWAIN or 
the HP Scanjet Plug-in (which is an Adobe® Photoshop® plug-in). 
A program is compliant if a command such as Acquire Image or 
From Scanner appears on a menu such as the File menu. 
If you are unsure whether your program complies with TWAIN 
standards or supports Photoshop plug-ins—or you do not know the 
command for inserting a scanned item, see the documentation for 
the program.

See "Scanning from other programs" on page 74.

Using the HP Scanjet Copy Utility  

Use the HP Scanjet Copy Utility when you need to make standard 
copy adjustments, such as reducing or enlarging, or lightening or 
darkening. You can also choose a printer other than the default.
To start the utility: in the HP Scanning Software folder, double-click 
HP Scanjet Copy Utility. For help using the utility, move the pointer 
over the button or option to find more information about the feature.
Download from Www.Somanuals.com. All Manuals Search And Download.
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Selecting and preparing items

Before placing items in the scanner, follow these guidelines for 
selecting and preparing them to prevent damage to the items and the 
scanner.

CAUTION Improper placement and scanning can damage the 
items and the scanner.

Items for the scanner glass 

The scanner glass can scan the widest range of items, including:

l paper items

l news clippings, receipts, and business cards

l items on all weights of media, including media lighter than 60 g/m2 
(16 lb) or heavier than 105 g/m2 (28 lb)

l gum-backed paper

l multipart forms with carbon pages

l old or worn photographs or documents

l items containing tears, perforations, punch holes, wrinkles, or curls

l flatter, three-dimensional items such as fabric, pages in books, and 
paper with texture

CAUTION Avoid placing items with sharp edges on the scanner 
glass. Doing so can damage the scanner.

Before placing an item on the scanner glass, make sure the item is free 
of wet glue, correction fluid, or other contaminating substances.

Items for the ADF 

The HP Scanjet Automatic Document Feeder (ADF), which is a fast, 
convenient way to scan multiple-page items, is included or supported 
on some scanner models. See "Front panel and accessories 
comparisons" on page 3. The ADF accepts items that meet the 
following specifications:

l items on standard Letter-, A4-, and Legal-size paper

l items consisting of as many as 25 unbound pages

l items ranging in size from 88.9 by 127 mm (3.5 by 5 inches) to 
215.9 by 355.6 mm (8.5 by 14 inches)

l items ranging in weight from 60 to 90 g/m2 (16 to 24 lb)

l items that are square or rectangular and in good condition (not 
fragile or worn)

l items that are free of tears, perforations, or punch holes

l items that are free of wet glue, correction fluid, or ink

Avoid multipart forms with carbon pages, transparencies, magazine 
pages, gum-backed pages, and light “onionskin” pages.

Before placing an item in the ADF, prepare the item by doing the 
following:

l Remove curls or wrinkles. 

l Remove staples, paper clips, paper sticky notes, and any other 
materials from items.

If your item does not meet these guidelines or you cannot prepare it as 
stated, use the scanner glass.
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Items for the XPA

The HP Scanjet Transparency Adapter (XPA) is included with some 
scanner models or can be ordered. Use the XPA and its templates to 
scan:

l 35 mm photographic negatives

l 35 mm slides

Because these items are easily damaged, handle them only by their 
edges.
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Completing your first scan 

This section shows you how to take the same item and scan to print 
using the two primary scanning methods:

l Scanner buttons 

l HP Precisionscan Pro software 

Before scanning, place the item in the scanner.

��
����
	��
�	�
��
	��
�������


1 Choose an item to scan, such as a page from a magazine.

2 Place the item face down on the scanner glass and close the lid.

3 See "To complete your first scan using the scanner buttons" on 
page 20.
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1 Load the item in the scanner. See "To load the item in the scanner" 
on page 19.

2 On the scanner, press the Copy button ( ). The scanner scans 
the item using settings optimized for printing this type of item and 
then prints the item to the default printer. 

3 If the scan does not work, or you have difficulty with this process, 
please see "Resolving issues that did not generate messages" on 
page 90.

If you have not already scanned using the HP Precisionscan Pro 
software, see "To complete your first scan using the 
HP Precisionscan Pro software" on page 21.

Copy button
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1 Load the item in the scanner. See "To load the item in the scanner" 
on page 19.

2 With the item loaded, press the Scan To button ( ) on the 
scanner. The scanner scans the item to the HP Precisionscan Pro 
software, choosing the best settings for this type of item.

3 When the scanned image appears in the preview window of the 
software, draw a selection border around the image or portion of 
the image you want. To do so, click on one corner of the area you 
want, and while holding down the mouse button, drag the cursor to 
the opposite corner. Release the mouse button to complete the 
border.

4 Experiment with the image. Change the output type or make other 
adjustments.

5 When you finish: On the Scan menu, click Print. 
6 Select any printer options you want and click OK. The scanner 

performs a final scan including your changes, and the scanned 
image prints.

7 If the scan does not work, or you have difficulty with this process, 
please see "Resolving issues that did not generate messages" on 
page 90.

If you have not already scanned using the scanner buttons, see "To 
complete your first scan using the scanner buttons" on page 20.

Selection 
border
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Frequently asked questions

This section contains answers to some questions frequently asked 
about scanning.
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Based on the scanned item, the software automatically chooses 
optimal values for these settings:

l output type

l resolution

l sharpening

l exposure (midtones, highlights, and shadows)

l color (hue and saturation or black & white threshold)

Usually, the values the software selects provide optimal results. 
However, you can change these values in the HP Precisionscan Pro 
software.
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You can reduce the time it takes to scan an item by scanning in black 
and white when the original is one of the following:

l a black-and-white photograph or drawing

l a color photo or drawing, but you want a black-and-white image to 
appear on the computer screen

l an item that contains only text

Another option is to reduce file size. See "How can I reduce the file 
size?" on page 23.
Print color originals as black and white by selecting the Black & White 
option on the front panel and pressing the Copy button ( ). Or, in 
the HP Precisionscan Pro software, choose the Grayscale or Black & 
White output types before your final scan (after the scanner completes 
a preview scan). See "Selecting output type" on page 43.
In the HP Scanjet Controls control panel, select the Faster Scan 
setting on the Lamp tab. When selected, this setting allows you to set 
a time for the scanner to turn on. After this time, the scanner lamp and 
the XPA light source (if connected) stay on for ten hours and then turn 
off. See "Setting scanner lamp controls" on page 107.
Download from Www.Somanuals.com. All Manuals Search And Download.



Back to TOC Getting started 23
���
���
�
������
	��
����
�����

To reduce file size:

l Save files using a compressed format, such as TIFF compressed 
or JPEG.

l Avoid using the True Color output type unless necessary. This 
output type offers exceptional quality for color photos or drawings, 
but it also creates large file sizes.

l Set the resolution no higher than necessary. Generally, the 
resolution the software automatically sets provides the best 
balance between image quality and small file size.

l For photos, significantly reduce file size by cropping the photo to 
select just one area as the final scanned image. Or, resize the 
entire photo to smaller dimensions.
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The HP Precisionscan Pro software sets the resolution for you based 
on the original document attributes. In almost all cases, you get the 
best results and the smallest file size using the default resolution.
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A computer screen usually displays images at 72 to 75 pixels per inch 
(PPI). Print resolution is usually higher. Screens also use fewer colors 
to display an image. Even if an image looks incorrect on the screen, it 
might print the way you want.

���	
��
	��
����������
��	����
������
���
���������

Use Zoom In to view an area of the scanned image close up. Use 
Zoom Out to return to the original view of the image. 
The zoom commands do not change the final size of your scan; they 
just give you a different view on a monitor. To reduce or enlarge the 
size of the final scan, use the Resize command on the Tools menu.
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When you scan an item containing text, you can use the text either as 
a scanned image, such as a fax or photo archive, or as text you can 
edit. 
To have the optical character recognition (OCR) software make the 
text editable automatically and send the text to a supported word-
processing program, press the Scan To button ( ). In the 
HP Precisionscan Pro software, choose Scan To from the Scan menu. 
Then choose Text File from the Destination pull-down menu and click 
Scan.

Tip Perform a spell-check after you have successfully 
scanned your text to a word-processing program.
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2 Scanning from scanner buttons 

The scanner buttons provide an easy way to scan items directly to 
destinations using settings optimized for the destination you choose. 
You do not view or change scanned images before they go to the 
destination.
To view or change images, scan to the HP Precisionscan Pro software 
using the Scan To button ( ). For more help viewing or changing 
images, see "Overview of the HP Precisionscan Pro software" on 
page 39.

Tip You can change the default settings for buttons on 
the scanner. See "Configuring scanner buttons" on 
page 35.
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Overview of scanner buttons

For a list of buttons available on your scanner, see "Front panel and accessories comparisons" on page 3.

Scan To 
Scan to the HP Precisionscan Pro software. View the image or make adjustments, such as changing 
resolution or resizing. If your scanner also has a Select Destination button (some models only) next to the 
Scan To button, you can select and scan to other programs on your computer.

Select Destination (some models only)
Press this button up or down to choose a program, then press the Scan To button. The Scan To button scans 
the item using settings optimized for that destination and sends the scan to that destination.

Share-to-Web (some models only)
Scan a photo and send it to the HP Share-to-Web Wizard on your computer. The HP Share-to-Web Wizard 
uploads the image to a website.

Photo Reprint
Scan a photo and send it to the photo printing software for printing multiple photos on one page or for 
creating photo album pages. 

E-mail
Scan using settings optimized for e-mail. The e-mail program window automatically launches so you can 
compose your message. The scanned image becomes a file attachment in the new e-mail message. If you 
do not have a supported e-mail program, this button allows you to save the scanned image as a file.

Copy

Print copies using settings optimized for printing. At the computer, you can press +. 
(COMMAND KEY+PERIOD) to cancel the scan.
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Number of copies (some models only)
Choose the number of copies before pressing Copy. The liquid crystal display (LCD) shows the number of 
copies selected.

Color/Black & White copy (some models only)
Choose the color or black and white setting before pressing Copy to ensure the best settings are used. Only 
use color copy if you are printing to a color printer and want a color copy. The light adjacent to the currently 
selected choice is lit.

More Options (some models only)
Open the HP Scanjet Controls control panel to change settings, such as resolution, for some buttons on the 
scanner. If your scanner does not have this button, open the HP Scanjet Controls control panel from your 
computer to change button settings. See "Configuring scanner buttons" on page 35.

Cancel (some models only)
Cancel a scan while the scanner is in the process of scanning, or cancel a series of scans from the HP 
Scanjet Automatic Document Feeder (ADF).

Power Save
Puts the scanner in an energy-conservation mode. The scanner lamp and a small indicator light near the 
Power Save button turn off. To use the scanner, press any button on the front panel of the scanner or start a 
scan from the computer. The scan begins when the lamp is ready.
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Scanning quickly with scanner buttons

Use the scanner buttons to scan quickly to a destination using settings 
optimized for that destination. A destination is a printer, file, or another 
program, such as your e-mail or word-processing program.

If you are scanning slides or negatives using the HP Scanjet 
Transparency Adapter (XPA), you must scan from the HP 
Precisionscan Pro software. See "Scanning from the XPA" on page 79.

Scanning to the HP Precisionscan Pro software

When you use the Scan To button ( ), you send directly to the HP 
Precisionscan Pro software. Using the HP Precisionscan Pro software, 
you can preview scanned images and make changes to the images 
before you send them to a destination or file them. 
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1 If your scanner has a 16-character LCD, make sure that either 
Powersave On, Ready, or HP Precisionscan appear on the LCD. 
(See "Front panel and accessories comparisons" on page 3.) 

Note: If another program name appears in the LCD, press the 
Select Destination button ( ) up or down until 
HP Precisionscan is listed in the scanner’s LCD. 

2 Close the HP Scanjet Copy Utility and the HP Scanjet Controls 
control panel if they are open on your computer.

3 Place the original face down on the scanner glass and close the lid. 
To load items in the ADF, see "Scanning from the ADF" on 
page 78.

4 Press the Scan To button on the front panel of the scanner.
5 Your computer opens the HP Precisionscan Pro software. A 

preview of the scan appears in the Precisionscan Pro software 
window.

For more information, see "Scanning from HP Precisionscan Pro" on 
page 39.

Tip When scanning multiple pages without using an 
ADF, the computer might prompt you for another 
page. The HP Precisionscan Pro software adds 
these pages to the current file. (To turn this feature 
off, see "Changing settings for buttons" on 
page 35.)
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Scanning to another program

On some models, you can select from a list of destinations (including 
the HP Precisionscan Pro software) on the front panel LCD, then scan 
directly to the selected destination.
When you select a program other than HP Precisionscan Pro using the 
Select Destination button ( ), the scanner will automatically use 
settings optimized for the destination you choose. You do not view or 
change scanned images before they go to the destination.
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1 Close the HP Precisionscan Pro software, the HP Scanjet Copy 
Utility, and the HP Scanjet Controls control panel if they are open 
on your computer.

2 Place the original face down on the scanner glass and close the lid. 
To load items in the ADF, see "Scanning from the ADF" on 
page 78.

3 If your scanner has a Select Destination button next to the Scan To 
button ( ), press the Select Destination button up or down until 
the destination you want to scan to is listed in the scanner’s LCD.

4 Press the Scan To button on the front panel of the scanner.
5 The item is scanned using settings optimized for the program you 

selected. The program launches and the scan is sent to the 
program.

Note: For information about selecting and updating the 
destinations for scanner buttons, see "Changing 
settings for Speed Destinations (some models only)" on 
page 36.

Tip If your scanner does not have a Select Destination 
button next to the Scan To button, you can scan to 
other programs through the HP Precisionscan Pro 
software. See "Sending to a program" on page 60.
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Sending a scan to a website

On some models, you can share images with other people by scanning 
directly to the Web with the Share-to-Web button ( ). People you 
know can view photos and other items by visiting your website, which 
will have its own address.
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1 Close the HP Precisionscan Pro software, the HP Scanjet Copy 
Utility, and the HP Scanjet Controls control panel if they are open 
on your computer.

2 Place the original face down on the scanner glass and close the lid. 
To load items in the ADF, see "Scanning from the ADF" on 
page 78.

3 Press the Share-to-Web button on the front panel of the scanner. 
The scanner scans the item using settings optimized for the Web. 
Your computer opens the HP Share-to-Web Wizard. 

4 Follow the instructions on the screen to finish posting the scanned 
image to your website.

Scanning for photo reprints

You can scan photographs and prepare them for photo reprints by 
using the Photo Reprint button ( ). Photo reprints optimize the use 
of photo paper, allowing you to print multiple photos on one page. You 
can also create pages with multiple photographs for projects such as 
photo albums. 
At the computer, use the photo printing software provided with your 
scanner to arrange photographs, make adjustments, and print 
photographs.
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1 Close the HP Precisionscan Pro software, the HP Scanjet Copy 
Utility, and the HP Scanjet Controls control panel if they are open 
on your computer.

2 Place the original face down on the scanner glass and close the lid.
3 Press the Photo Reprint button on the front panel of the scanner. 

The scanner scans the item using settings optimized for 
photograph printing. Your computer opens the photo printing 
software. 

Tip If your scanner does not have a Share-to-Web 
button, scan to the Web using your HP 
Precisionscan Pro software. See "Placing a scan on 
a website" on page 64.
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E-mailing a scan

When you send e-mail using the E-mail button ( ), the scanner 
scans the item using default settings optimized for mailing. If you have 
a supported e-mail program, the scanned image automatically appears 
as a file attachment in a new e-mail message, which you then address 
and send. 
If your e-mail program is not supported, see Unsupported e-mail 
programs on this page.
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Supported e-mail programs allow the scanner to scan an item as a file 
and attach it to a new e-mail message. If a scanned image 
automatically appears as a file attachment in a new e-mail message, 
your e-mail program is supported.
See "Configuring scanner buttons" on page 35 to check or change 
which e-mail program is set as the default.
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If you are using an unsupported e-mail program, such as the Web-
based program Microsoft Hotmail®, the scanner cannot scan items 
directly into an e-mail message. Instead, the computer can prompt you 
to save the item as a file before the scanner completes the scan. 
To enable the computer to prompt you to save an item as a file, 
complete the following steps:
1 Choose Control Panels from the Apple ( ) menu, and then 

choose HP Scanjet Controls from the submenu.
2 Click the Buttons tab in the HP Scanjet Controls dialog box, and 

then click the E-mail tab.
3 In the Destinations pull-down menu, select a destination. See 

"Destinations options" on page 37 for more information.
4 Select an appropriate type of file for the destination you’ve 

selected. 
5 Close the HP Scanjet Controls dialog box.
6 Press the E-mail button ( ) and when prompted, save the 

scan.
After the scan is completed, open an e-mail message and attach the 
file as you normally do.

Tip To view the scanned item before you send it, open 
the file attachment from the new e-mail message.
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1 Close the HP Precisionscan Pro software, the HP Scanjet Copy 
Utility, and the HP Scanjet Controls control panel if they are open 
on your computer.

2 Place the original face down on the scanner glass and close the lid. 
To load items in the ADF, see "Scanning from the ADF" on 
page 78.

3 Press the E-mail button on the scanner.

Note: If you do not have a supported e-mail program, the 
computer might open the HP Scanjet Controls control 
panel. See "Unsupported e-mail programs" on page 31 
for more information.

4 If the computer prompts you for an attachment file name, type a 
name in the Name box. If you need more help, see "Naming e-mail 
attachments" on page 32.

5 If you have a supported e-mail program, the scanned image 
automatically appears as a file attachment in a new message. 
Address the message and send it as you normally do. If you do not 
have a supported e-mail program, open your e-mail program and 
attach the saved file.
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The computer will prompt you each time for a file name. If you do not 
want to be prompted, and you want the scanning software to assign an 
attachment name automatically, see "Configuring scanner buttons" on 
page 35.
Format displays the file type for the e-mail attachment. 

Note: If you need to send the item as a file type other than the 
file type shown, scan and save the item using the HP 
Precisionscan Pro software. See "To save to a file" on 
page 61.
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Printing copies 

You can scan an item and send it to a printer to make copies using the 
scanner button. At the computer, you can see the progress of the scan 
or you can cancel the scan. (If you cancel the scan, the printer might 
feed a blank page to the output bin.) Note that when you make copies, 
each page is treated as a separate print job, so the printer does not 
collate copies.
Using the scanner button allows you to scan an item and send it to a 
printer using default printer and scanner settings. To change the 
default printer or scanner settings, open the HP Scanjet Copy Utility in 
the HP Scanning Software folder. 
On some scanner models, you can also change the number of copies 
or select color or black and white copies from the scanner front panel. 
If your scanner does not have buttons for changing the number of 
copies or selecting color or black and white copies, open the HP 
Scanjet Copy Utility to make these adjustments. (See "Front panel and 
accessories comparisons" on page 3.)
For more information, see "Using the HP Scanjet Copy Utility" on 
page 16.
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1 Close the HP Precisionscan Pro software, the HP Scanjet Copy 
Utility, and the HP Scanjet Controls control panel if they are open 
on your computer.

2 Place the original face down on the scanner glass and close the lid. 
To load items in the ADF, see "Scanning from the ADF" on 
page 78.

3 (Some models only, see "Front panel and accessories 
comparisons" on page 3.) On the scanner, select color or black and 
white copies.

4 (Some models only, see "Front panel and accessories 
comparisons" on page 3.) On the scanner, select the number of 
copies. The default setting is one copy.

5 Press the Copy button on the scanner. Unless you press +. 
(COMMAND KEY+PERIOD) on the computer to cancel the scan, the 
number of copies specified in the scanner LCD will print directly to 
the default printer.
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Canceling a scan

On some scanner models, you can use the Cancel button ( ) to 
cancel a scan in progress. When you press the Cancel button during a 
scan, the lamp returns to its starting position. If you press the Cancel 
button during a scan from the ADF, the ADF ejects any pages that are 
in the process of scanning.
For information about which scanners include a Cancel button, see 
"Front panel and accessories comparisons" on page 3.

Using Power Save

Use the Power Save button ( ) to conserve energy when you are not 
using the scanner. When you press the Power Save button, the 
scanner lamp and a small indicator light near the Power Save button 
turn off and the scanner lamp returns to its starting position. 
To use the scanner again, press any button on the front panel of the 
scanner or start a scan from the computer. After a short warm-up 
cycle, the scan begins.

Tip You can also cancel a scan by pressing +. 
(COMMAND KEY+PERIOD) on the computer.
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Configuring scanner buttons

Each scanner button has default settings that optimize the scan for the 
destination (such as an e-mail program) that is associated with the 
button you press. 

Changing settings for buttons

You can change the default settings for individual scanner buttons. 
These changes are applied to all items you scan using that button until 
you change the settings again. 
For more information about the settings you can change, see "Settings 
for scanner buttons" on page 37.
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1 Do one of the following:
l On the scanner, press the More Options button ( ). (Some 

models only, see "Front panel and accessories comparisons" on 
page 3.) 

l Choose Control Panels from the Apple ( ) menu, and then 
choose HP Scanjet Controls from the submenu.

2 On the Buttons tab, click the tab for a scanner button to display the 
settings that you can change.

Note: If you click the Scan To tab with some scanner models, 
the computer displays a list of destinations (called 
Speed Destinations). Skip to "To change settings for 
Speed Destinations" on page 36 and go to step 3. 

3 Change settings for the button. See "Settings for scanner buttons" 
on page 37 for more information.

4 Repeat steps 2 and 3 to change settings for other buttons.
5 To restore the default settings, repeat step 2 for any button and 

click Restore Defaults.
6 When finished, click the close box. 

Tip To change the settings only for the current item, you 
might want to scan using the HP Precisionscan Pro 
software instead. See "Scanning from HP 
Precisionscan Pro" on page 39.
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Changing settings for Speed Destinations (some models 
only)
 


On some scanner models, you can use the Select Destination button 
to select a destination (called a Speed Destination) when scanning 
directly from the scanner front panel. You can change settings for the 
Speed Destinations that appear in this list using the HP Scanjet 
Controls control panel. 
To see if your scanner model includes Speed Destinations, see "Front 
panel and accessories comparisons" on page 3. For more information 
about the settings you can change, see "Settings for scanner buttons" 
on page 37.

Note: You cannot change the Prompt for e-mail attachment 
name, Prompt for another page, or Automatic 
Cropping settings for the Scan To button with Speed 
Destinations.

��
������
��		����
���
�����
%��	���	����

1 Do one of the following:
l On the scanner, press the More Options button ( ).
l Choose Control Panels from the Apple ( ) menu, and then 

choose HP Scanjet Controls from the submenu.
2 On the Buttons tab, click the Scan To tab. The computer displays 

a list of available scanning destinations and the current settings for 
these destinations.

3 Select a destination from the list, and then click Edit. The Edit 
Destination dialog box appears.

4 Change the settings for the destination. For information about 
these settings, see "Settings for scanner buttons" on page 37.

5 When finished, click OK. The changes you made appear in the 
columns next to the destination.

6 Repeat steps 3 and 4 to change settings for another destination.
7 To return to the default settings for a destination:

 a Repeat step 3.
 b Click Restore Defaults, and then click OK.

Tip If the destinations that appear on the scanner do not 
match the destinations on the Scan To tab of the 
HP Scanjet Controls control panel, click Update 
Scanner to send the new destinations to the 
scanner.
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Settings for scanner buttons

Using the HP Scanjet Controls control panel, you can change the 
following types of settings for the buttons on your scanner. 

l Destination options (See "Destinations options" on page 37.)

l Image options (See "Image options" on page 38.)

l ADF Page Size options (See "ADF Page Size options" on 
page 38.)

Depending on the destination selected in the Destination pull-down 
menu, some options might not be available.

Note: Some scanner models also include Speed Destinations 
for the Scan To button. See "Changing settings for 
Speed Destinations (some models only)" on page 36.
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Destinations
The Destinations pull-down menu lists the available destinations on 
your computer. These destinations include the following:

l File types: Options include Image, Text, and Image and Text. 
Choose Image when scanning items that you want to be saved 
using an image file type, such as JPEG. Choose Text when 
scanning items containing only text that you want to edit in a word-
processing program. Choose Image and Text when you are 
scanning items containing both images and text you want to edit.

l Programs: The HP Precisionscan Pro software recognizes the 
programs listed in the pull-down menu.

l None: When None is selected and you press the scanner button, 
the HP Scanjet Controls control panel opens on your computer, 
allowing you to select a destination for the scan.

Type of file
When Image is selected, the scanned image is saved as an image file. 
If the scanned image contains text, this text is not editable.
When Text is selected, output is converted to one column in what the 
software perceives to be the most logical order. Graphics or pictures 
from the scanned item are discarded. Use this option to make more 
extensive changes to text.
When Image and Text is selected, output is converted to a format that 
creates editable text. Any graphics or pictures in the scanned item are 
preserved.
Prompt for Another Page
When this option is selected, a prompt appears on the computer after 
you scan the first page of a job. The prompt asks if you have more 
pages to scan to this job. 
When this option is not selected, you will not be prompted for more 
pages. Each scanning job will be treated as a single-page job.
When changing settings for Speed Destinations, this option is not 
available. To scan multiple pages, use the ADF or the 
HP Precisionscan Pro software.
Prompt for e-mail attachment name
When this option is selected, the scanning software prompts you to 
enter a name each time for e-mail attachments.
When this option is not selected, the scanning software assigns an 
attachment name automatically.
When changing settings for Speed Destinations, this option is not 
available. The names for e-mail attachments are generated 
automatically. If you need to specify names for e-mail attachments, use 
the E-mail button to scan the item.
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Resolution
Select a resolution from the pull-down menu, or type a resolution in the 
text box.
Output Type
From the Output Type pull-down menu, select one of the options 
below:

l True Color creates an image that is rendered with 24-bits per pixel 
per color.

l 256 Color Palette creates an image that contains the 240 most 
common colors in the image, plus the 16 basic colors.

l Grayscale creates an image containing shades of gray, not just 
black and white. In a grayscale image, each pixel contains multiple 
bits of information, allowing more shades of gray to be recorded 
and displayed. 

l Black & White creates an image that contains only black pixels 
and white pixels, no colors or shades of gray. Each pixel 
represents one bit.

For more information about using these options, see "List of file types" 
on page 62.
Automatic Cropping
When this option is selected, the scanner includes only the item or 
items placed in the top right corner of the scanner glass in the scanned 
image.
When this option is not selected, the scanner includes the entire area 
of the scanner glass, including blank areas, in the scanned image.
When changing settings for Speed Destinations, this option is not 
available. Instead, if the destination you are using scans the item using 
the Image option, Automatic Cropping is selected. If the destination 
scans the item using the Text or Image and Text option, Automatic 
Cropping is not selected.
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If you are using an ADF with the scanner, select the size of the pages 
you load in the ADF:

l Letter

l Legal

l A4

For more information about loading items in the ADF, see "Scanning 
from the ADF" on page 78.
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3 Scanning from HP Precisionscan Pro

Using the HP Precisionscan Pro software, you can preview scanned 
images and make changes to the images before you send them to a 
destination or file them. You start the HP Precisionscan Pro software 
from a scanner button or the HP Scanning Software folder on your 
computer.
You can also start the HP Precisionscan Pro software from another 
program, such as a word-processing or image-editing program, if the 
program is compliant with TWAIN or supports the HP Scanjet Plug-in. 
See "Scanning from other programs" on page 74 for more information.

Overview of the HP Precisionscan Pro 
software

The HP Precisionscan Pro software provides preview capabilities and 
tools for changing an image. Some of the changes you can make 
include:

l select only part of, or crop, the preview image to become the final 
scanned image

l change the resolution

l resize the scanned image

l change the contrast
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Starting the HP Precisionscan Pro software

To start the HP Precisionscan Pro software, press the Scan To button 
( ), or in the HP Scanning Software folder, double-click 
HP Precisionscan Pro. The software starts.
To view the function of a command, place the cursor over the 
command until an explanation appears.
For more information about the types of assistance the software itself 
offers, see “Finding help for using the software” on this page. For more 
information about keyboard shortcuts, menu items, toolbars, and 
cursor appearance, see "Using software commands and controls" on 
page 115.

Finding help for using the software

The HP Precisionscan Pro software provides a variety of assistance. 
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Smart Friends are tips that appear automatically to notify you of 
potential problems. For example, if you are setting a very high 
resolution but want to use e-mail to send the scanned image, a Smart 
Friend would alert you that the file will probably be too large to e-mail. 
To turn individual messages off, select the Don’t remind me again 
check box in the message’s dialog box. To turn all messages off, click 
Disable All Smart Friends on the Help menu. To turn all messages 
back on, click Enable All Smart Friends.
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The online Help is an easy-to-use source of information about using 
the scanner and software, troubleshooting, support, and specifications. 
To gain access to the Help: on the Help menu, click 
HP Precisionscan Pro 3.1 Help. Or, click the Help button in any 
dialog box in which it appears.
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Performing a new scan

Once you start a new scan, the scanner does a preliminary scan of the 
item and displays the scanned image in the HP Precisionscan Pro 
software. Then, you can see the scanned image and edit it, if 
necessary, before sending it to a destination or saving it as a file.
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Use these steps to start a scan from the HP Precisionscan Pro 
software. To start a scan from a scanner button, see "Scanning quickly 
with scanner buttons" on page 28.
1 Place the original face down on the scanner glass and close the lid. 

Note: To load items in the HP Scanjet Automatic Document 
Feeder (ADF), see "Scanning from the ADF" on 
page 78.

2 Start the scan in one of these ways:
l In the HP Precisionscan Pro software, click  on the toolbar.
l In the HP Precisionscan Pro software, click New Scan on the 

Scan menu.
The scanned image appears in the HP Precisionscan Pro software. 
This scanned image is the preview image. You can make changes, 
such as selecting only part of the image or adjusting the contrast. 
When you send the image to another program such as e-mail, place 
the image on a website, or save it as a file, the scanner performs a final 
scan of the item that includes any changes you made. Directions for 
making optional adjustments and completing the scan appear in this 
section.
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Cropping or selecting an area for final 
scan

Once a scanned image appears in the HP Precisionscan Pro software, 
you must select which area becomes the final scanned image by 
creating a selection area. When you create a selection area, a dotted 
selection border appears around the area:

For information about the appearance of the cursor when it is over an 
area of the selection border, see "Context-sensitive cursors" on 
page 121.
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Do one of the following:

l Move the cursor over the area you want and click.

l When the cursor looks like this: , click on one corner of the area 
you want and drag the cursor to the opposite corner to draw a 
rectangular selection area.

l On the Edit menu, click Select All. The entire scanner bed, 
including blank areas, is selected. 
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Click the edge of the selection border and drag to change the selection 
area.
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Move the cursor over the selection area. When the cursor looks like 
this: , click and drag the selection border to the new location.
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Do one of the following:

l Press ESC.

l On the Edit menu, click Unselect All.

Tip If you only want to look more closely at an area 
without changing what will be included in the final 
scan, see "Getting a closer look (zooming)" on 
page 43.

selection 
border
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Getting a closer look (zooming)

Zoom in on the selection area to look at it more closely or make 
changes to it. Zoom out to view the entire preview image, or so you 
can select a different area of the image to view. Zooming in on the 
selection area before making changes or performing a final scan 
provides the best final results. The zoom commands are not available 
if you have not created a selection area.
Zooming in and out does not change which part of the image becomes 
the final scan, nor does it change the final output size (physical output 
dimensions). To change which part of the image becomes the final 
scanned image, see "Cropping or selecting an area for final scan" on 
page 42. To resize the image, see "Resizing (output dimensions)" on 
page 45.
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After creating a selection area, do one of the following:

l On the View menu, click Zoom in. 

l Click .
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Do one of the following:

l On the View menu, click Zoom out to return to the original view of 
the image.

l Click .

Selecting output type 

When Automatically Set Type is selected, the scanning software 
automatically chooses an output type based on the type of item you 
are scanning. However, you can change the output type yourself when 
you want. Choose the output type based on how you will use the final 
scanned image as well as the type of item you are scanning.
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1 Do one of the following:
l If it is not already selected, click Automatically Set Type on the 

Output Type menu, to allow the software to choose the best 
output type for this type of original item. 

l To change the output type only for this scan, keep 
Automatically Set Type selected and select an output type you 
want from the Output Type menu. See "List of output types" on 
page 44.

l To change the output type for this scan and all other scans in 
this session, clear Automatically Set Type and select an output 
type you want from the Output Type menu. See "List of output 
types" on page 44.

Tip When you redraw the selection border, the output 
type might change if Automatically Set Type is 
selected in the HP Precisionscan Pro 
Preferences dialog box.
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On the Output Type menu, click Automatically Set Type. The 
software chooses the best output type based on the image inside the 
selection area.

For these uses Use this output 
type

Color photos or drawings with lots of shading to be: 
l printed on a color printer
l displayed on a color monitor set to millions of colors
l displayed on Web and saved in the JPEG or PNG file 

format

True Color 

Color photos or drawings with shading to be:
l printed to a color printer
l sent via e-mail
l used in any way that requires a small file size
l viewed on a computer screen

Optimized Palette

Color photos or drawings with shading to be:
l printed to a color printer
l displayed on a monitor set to 256 colors
l displayed on Web and saved as a GIF file

System Palette

Color photos or drawings with shading to be printed to a 
B&W printer.

Grayscale

B&W photos and drawings with shading to be used for any 
purpose.

Grayscale

B&W drawings without shading to be placed in another 
program without resizing in the other program.

Black & White 
Bitmap

Any image to be saved in GIF file format and displayed on 
the Web.

Web Palette

Color drawings or logos without much shading and with a 
concentrated area of a single color. The image is to be used 
for any purpose.

Spot Color
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Making optional adjustments, basic

These tools are needed most often, but using any of them is optional. 
Depending on the output type chosen, some tools will not be available.

Note: When a tool is open on the desktop, the HP 
Precisionscan Pro software scans the item using the 
current settings in the tool. However, these settings 
might not be the best settings for the type of item being 
scanned. To enable the scanner to scan using the best 
settings automatically, close the tool.

Resizing (output dimensions)

You can resize the image before you do the final scan by changing the 
output dimensions. Resizing the scanned image to the actual 
dimensions you need before performing the final scan helps ensure 
the best image quality.
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1 On the Tools menu, click Resize. The Resize dialog box opens.
2 Do one of the following:

l If necessary, select a unit of measure in the Units field. In the 
Output Dimensions area, type a new value in the Width or 
Height field and press ENTER.

l In the Scale field, select a scale percentage.
New values appear in the Scale, Width, and Height fields, but the 
selection area and the scanned image on screen remain the same. 
Resizing occurs when you complete the scan.

3 If you want, click . This locks the output dimensions you 
defined so you can change the selection area without changing the 
output dimensions. When you change the selection border, the 
software resizes the border proportionally. The output dimensions 
remain the same.

Tip If you need to resize images to fit in a file, such as 
word-processing document, resize them here in the 
scanning software. Resizing images in the other 
program may cause them to be fuzzy or have 
jagged edges.
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Changing resolution 

Resolution determines the amount of data in a scanned image. The 
scanning software chooses the optimal resolution based on the output 
type. This resolution generally does not need to change. 
If you do change the resolution, choose one no higher than the 
capabilities of the monitor or printer and one appropriate for the type of 
scanned image. For example, to print on a 600 dpi printer, choose 600 
for black and white bitmap images, but choose only 200 for color or 
grayscale images. These resolutions produce optimal quality while 
keeping file sizes small.
Selecting higher resolutions for color images increases file size while 
not increasing quality. If you double the resolution, the file size 
quadruples. Large file sizes can prevent you from doing certain tasks, 
such as e-mailing, or can take up too much space on your computer.
For help choosing a resolution based on the type of original item and 
destination, see "Tips for best image quality" on page 69.
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On the Tools menu, click Resolution. 

Note: When the Resolution tool is enabled, a checkmark 
appears beside the Resolution command in the Tools 
menu, and the Resolution tool appears in the toolbar. 
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1 Open the Resolution tool, if it is not already open. 
2 Do one of the following:

l Select a value from the list.
l Type a value between 12 and 999,999 in the field and press 

ENTER.
The resolution changes as soon as you select a value.
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1 Open the Resolution tool, if it is not already open. 
2 Click .

Changing contrast

The contrast is controlled by the midtone, highlight, and shadow 
settings. See "Changing midtones" on page 50, "Changing highlights" 
on page 51, and "Changing shadows" on page 52.
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Rotating an image

You can rotate the image in 90-degree increments clockwise or 
counterclockwise. You might need to rotate the image if you placed the 
bottom of the item at the top of the scanner glass, or if the item was 
sideways. Items such as negatives in their template often scan 
sideways.
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Do one of the following:

l To rotate an image clockwise: On the Tools menu, click Rotate 
right 90°. Or, click  on the toolbar. Repeat to continue turning.

l To rotate an image counterclockwise: On the Tools menu, click 
Rotate left 90°. Or, click on the toolbar. Repeat to continue 
turning.

Mirroring (reversing) an image

You can mirror, or reverse, an image from side to side on the vertical 
axis. Mirroring an image allows you to see the elements of the image 
on the opposite side of their actual position. Mirroring can be 
particularly useful for items such as negatives that might be placed in 
their template backward and scanned in reverse.
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On the Tools menu, click Mirror. Repeat to return to the original 
layout.
Download from Www.Somanuals.com. All Manuals Search And Download.



48 Scanning from HP Precisionscan Pro Back to TOC
Sharpening an image

Increasing sharpening enhances detail in the image. The 
HP Precisionscan Pro software automatically selects the optimal 
sharpen level, but you can change it.
You might want to increase sharpening if the image looks fuzzy. 
Conversely, you might want to decrease sharpening if the original item 
has flaws or marks on it. Increasing sharpening, or increasing it too 
much, can accent the flaws and create undesirable patterns. 
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On the Tools menu, click Sharpen. 

Note: When the Sharpen tool is enabled, a checkmark 
appears beside the Sharpen command in the Tools 
menu, and the Sharpen tool appears in the toolbar. 
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1 Open the Sharpen tool, if it is not already open. 
2 Select a sharpen level from the list. Check the preview image to 

see the effects of the change.

Note: To see the effects of the new sharpen level more easily, 
zoom in on the selection area. See "Getting a closer 
look (zooming)" on page 43.
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1 Open the Sharpen tool, if it is not already open. 
2 Click .

Resetting all adjustments 

You can reset images to the optimal (default) values the scanning 
software chose for the image. Optimal values are based on the output 
type selected. Resetting removes all adjustments you have made 
except the output type, zoom level, or the selection area.
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Do one of the following:

l On the Edit menu, click Reset Tools.

l On the toolbar, click .
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Making optional adjustments, advanced

These optional adjustments are ones that most people generally do 
not use or need, but some advanced users might want them for special 
effects or other needs. Depending on the output type chosen, some 
tools are not available.

Note: When a tool, such as Invert Colors, is open on the 
desktop, the HP Precisionscan Pro software scans the 
item using the current settings in the tool, instead of 
using automatic adjustment features. To enable the HP 
Precisionscan Pro software to use automatic 
adjustment features, close the tool. For more 
information, see "Setting preferences" on page 70.

Inverting the image

Use the Invert command to convert white areas of an image to black 
and black to white. For color images, a color is converted to its 
complementary color. Generally, this command is useful for drawings 
and spot color images.
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On the Advanced menu, click Invert Colors. Repeat to reverse the 
colors again. 
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Changing midtones 

The midtone setting lets you lighten or darken the middle values in an 
image. The range for the number in the Midtone field is 1.0 to 4.0. 
Moving toward 1.0 darkens the image. Moving toward 4.0 lightens the 
image. 
To adjust midtones for slides, negatives, or other transparent items, 
use "Adjusting midtones for slides or negatives" on page 83.
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1 On the Advanced menu, click Adjust Exposure.
2 Do one of the following:

l Drag the Midtone slider to the right.
l Type a higher number in the Midtone field and press ENTER.
l Click the Up arrow next to the Midtone field.
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1 On the Advanced menu, click Adjust Exposure.
2 Do one of the following:

l Drag the Midtone slider to the left.
l Type a lower number in the Midtone field and press ENTER.
l Click the Down arrow next to the Midtone field.
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1 On the Advanced menu, click Adjust Exposure.
2 Click Auto to return the midtone, highlight, and shadow to the 

default settings for this scanned image. Clicking Auto also returns 
output levels to the defaults. See "Setting pixel output levels" on 
page 54.

Tip If you are sharing the image with others who will be 
viewing it on a computer screen, the Midtone value 
2.2 is recommended because it is an average value 
that works with many different monitors. 

Midtone set at 1.8
(the default)

Midtone set at 3.0
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Changing highlights 

The highlight is the value in the image that is represented on the 
screen as white. All values lighter than the highlight also appear as 
white. 
The image has a default highlight setting. Selecting a higher number 
makes more of the lighter values distinct, which increases detail in light 
areas. Selecting a lower number makes fewer of the lighter values 
distinct, which reduces detail in the light areas. 
To adjust highlights for slides, negatives, or other transparent items, 
use "Adjusting highlights for slides or negatives" on page 84.
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1 On the Advanced menu, click Adjust Exposure.
2 Do one of the following:

l Drag the Highlight slider toward the right.
l Type a higher number in the Highlights field and press ENTER.
l Click the Up arrow next to the Highlight field.
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1 On the Advanced menu, click Adjust Exposure.
2 Do one of the following:

l Drag the Highlight slider toward the left.
l Type a lower number in the Highlights field and press ENTER.
l Click the Down arrow next to the Highlight field.
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Click  (white eyedropper). When the cursor changes to the 
eydropper, move it over the area you want to be the highlight and click.
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1 On the Advanced menu, click Adjust Exposure.
2 Click Auto to return the midtone, highlight, and shadow to the 

default settings for this scanned image. Clicking Auto also returns 
output levels to the defaults. See "Setting pixel output levels" on 
page 54.

Highlights set at 215 Highlights set at 122
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Changing shadows 

The shadow is the value in the image that is represented on the screen 
as black. All values darker than the shadow also appear as black.
The image has a default shadows value. Selecting a higher number 
makes more of the darker values distinct, which increases detail in 
dark areas. Selecting a lower number makes fewer of the darker 
values distinct, which reduces detail in the dark areas. 
To adjust shadows for slides, negatives, or other transparent items, 
use "Adjusting shadows for slides or negatives" on page 84.
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1 On the Advanced menu, click Adjust Exposure.
2 Do one of the following:

l Drag the Shadows slider toward the right.
l Type a higher number in the Shadows field and press ENTER.
l Click the Up arrow next to the Shadows field.
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1 On the Advanced menu, click Adjust Exposure.
2 Do one of the following:

l Drag the Shadows slider toward the left.
l Type a lower number in the Shadows field and press ENTER.
l Click the Down arrow next to the Shadows field.

��
�����	
�
)����
��
	��
������
)����

Click  (black eyedropper). When the cursor changes to the 
eydropper, move it over the area you want to be the shadow and click.
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1 On the Advanced menu, click Adjust Exposure.
2 Click Auto to return the midtone, highlight, and shadow to the 

default settings for this scanned image. Clicking Auto also returns 
output levels to the defaults. See "Setting pixel output levels" on 
page 54.

Shadow set at 10 Shadow set at 3
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Checking for clipped areas

The lightest or darkest areas of an image that will print without any 
detail in them are known as clipped areas. The lightest areas, or 
highlights, will print as the color of the paper (without ink or toner) and 
therefore will have no detail. The darkest areas, or shadows, will print 
saturated in the blackest color of ink or toner, and therefore will also 
have no detail. 
You can view and change clipped areas if you want those areas to 
contain detail when they print.
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1 On the Advanced menu, click Adjust Exposure.
2 Click  (Highlight Alarm). The light areas in the image that will 

print as white (no detail) appear black.
3 In the Highlights setting, click the Up arrow repeatedly until the 

clipped pixels disappear from the image. The result of the change 
can be seen.

4 Click  again to turn the Highlight Alarm off.
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1 On the Advanced menu, click Adjust Exposure.
2 Click  (Shadow Alarm). The darker areas in the image that will 

print as black (without detail) appear white.
3 In the Shadow setting, click the Down arrow repeatedly until the 

clipped pixels disappear from the image. The result of the change 
can be seen.

4 Click  again to turn the Shadow Alarm off.

Normal view View when 
Highlight 
Alarm 
selected

View when 
Shadow 
Alarm 
selected
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Setting pixel output levels

The output levels setting lets you create interesting effects for scanned 
pictures. When you select this command, the Black and White output 
levels appear. By default, white is set to 255, and black is set to 0. 
Decreasing the White output level makes the overall image darker. 
Increasing the Black output level makes the image more faded. 
Changing the White output level value to 0 and the Black output level 
value to 255 inverts the colors in the image. 
To change the ranges for the numbers in the White and Black fields, 
see the Controls tab of "Setting preferences" on page 70.
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1 On the Advanced menu, click Adjust Exposure.
2 Click the triangle at the bottom of the dialog box to display the 

current White and Black output levels.
3 To change the levels, do one of the following:

l Click one side of a slider.
l Type a different number in the White or Black field and press 

ENTER.
l Click the Up or Down arrow next to the White field or Black 

field.
The result of the changes to output levels can be seen in the preview 
area.
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1 On the Advanced menu, click Adjust Exposure.
2 Click Auto to return the midtone, highlight, shadow, and output 

levels to the default settings for this scanned image.

Tip To use an image as a light background for dark text, 
such as for an overhead transparency, increase the 
Black output level until the image is as faint as you 
want. 
Download from Www.Somanuals.com. All Manuals Search And Download.



Back to TOC Scanning from HP Precisionscan Pro 55
Viewing RGB values and pixels

You can view the RGB values and pixel color for any spot in a color or 
grayscale image using the RGB meter.
To view the RGB values and pixel color for slides, negatives, or other 
transparent items, use "Viewing RGB values and pixel color" on 
page 85.
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1 On the Advanced menu, click Adjust Exposure.
2 Move the pointer over the image. The RGB values and pixel color 

appear in the RGB meter.

Note: Do not click while the eyedropper pointer is over the 
image unless you want to change the setting for 
highlight or shadow.

3 Click the same eyedropper button again. The RGB meter dims and 
the cursor returns to normal.

About the histogram

The histogram is a graph of the distribution of pixels in the selection 
area. The magenta line represents the current setting for shadow. The 
red line represents the current setting for highlight. The midtone setting 
is not represented. 

The turquoise line appears in the histogram when either eyedropper 
cursor is positioned over the image. This line shows you where in the 
histogram the pixels in that area of the image occur.

The histogram represents pixel distribution in the preview image, not in 
the final scanned image. Changing the selection area changes the 
histogram. Changing the setting for highlight or shadow does not 
change the histogram. 

RGB 
values Pixel 

color

Shadow Highlight

Where pixels in the 
image under the 
eyedropper fall
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Changing the hue

Color in an image consists of its hue and the saturation. Hue refers to 
the overall color cast of the image. 
The software sets the hue for an image, but you can change it. You 
might want to change it if the image has too much of one color, or if you 
want to create a special effect.
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1 On the Advanced menu, click Adjust Color.
Change the overall color of the image by 
doing one of the following on the color 
wheel.

l Drag the indicator circle to a new 
area.

l Click the arrow for a color on the 
outer edge of the wheel.

The result of the change can be seen in 
the image.
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1 On the Advanced menu, click Adjust Color.
2 Click Auto to return to the default hue and saturation settings for 

this scanned image.

Changing the saturation

Color in an image consists of its hue and the saturation. Saturation 
refers to the intensity of the colors. 
The software sets the saturation for an image, but you can change it. 
You might want to change it to make colors in the image more or less 
vivid, or to create a special effect. The range in the Saturation field is 
0 to 150. 
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1 On the Advanced menu, click Adjust Color.
2 Make colors more vivid by doing one of the following:

l Click to the right of the slider.
l Type a higher number in the Saturation field and press ENTER.
l Click the Up arrow next to the Saturation field.
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1 On the Advanced menu, click Adjust Color.
2 Make colors less vivid by doing one of the following:

l Click to the left of the slider.
l Type a lower number in the Saturation field and press ENTER.
l Click the Down arrow next to the Saturation field.
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1 On the Advanced menu, click Adjust Color.
2 Click Auto to return to the default hue and saturation settings for 

this scanned image.

Tip If the image has too much of one color, move the 
indicator circle away from that color. 

Indicator circle

Arrows
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Changing the black and white threshold

Changing the black and white threshold only applies to images using 
the Black & White Bitmap output type. The threshold is a value in the 
image that represents the border between black and white. All values 
in the image that are lighter than the threshold appear as white, and all 
values darker appear as black.
The image has a default threshold value. Choosing a number closer to 
zero makes more values appear as white. Choosing a higher number 
makes more values appear as black. 
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1 Make sure that Black & White Bitmap is selected on the Output 
Type menu. The selection should have a dot beside it.

2 On the Advanced menu, click Adjust Black & White.
3 Do one of the following:

l Drag the slider.
l Type a new value in the field and press ENTER.
l Click the Up or Down arrow next to the field.
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1 On the Advanced menu, click Adjust Black & White.
2 Click Auto.Threshold at 127 

(the default for this image)

Threshold at 45
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Setting which colors become black or white in black & 
white bitmaps

This procedure only applies to color images that will be using the Black 
& White Bitmap output type. It allows you to create special effects, or to 
correct for originals on colored paper.
Images consist of pixels. In color images, each pixel has a varying 
amount of Red, Green, or Blue to create its specific color. You can 
determine whether the Red, Green, or Blue in each pixel turns to black 
or white in the final scanned image.
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1 Make sure that Black & White Bitmap is selected on the Output 
Type menu. The selection should have a dot beside it.

2 On the Advanced menu, click Adjust Black & White.
3 Select a color channel from the Scan using channel list.

l Choose Red to change the red in the image to white. Green and 
blue become black. Useful for originals printed on pink or red 
paper.

l Choose Green to change the green in the image to white. Red 
and blue become black. Useful for originals printed on green 
paper.

l Choose Blue to change the blue in the image to white. Red and 
green become black.Useful for originals printed on blue paper.

l Choose NTSC Gray to convert light shades of all colors to white 
and dark shades of all colors to black. (No one color becomes all 
white or all black.) Colors are converted to gray at a ratio of 30% 
red, 59% green, and 11% blue.

��
����	
	�
	��
������	
������

1 Make sure that Black & White Bitmap is selected on the Output 
Type menu. The selection should have a checkmark beside it.

2 On the Advanced menu, click Adjust Black & White.
3 Choose NTSC Gray from the Scan using channel list.
4 Click Auto.
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Descreening images

Use the Descreen command to reduce undesirable patterns in printed 
items you are scanning. An example of an undesirable pattern is a 
moiré pattern, or the circles that often appear on pictures printed in 
newspapers.
Note that scanning takes longer when this command is selected. Use 
Descreen only when you see undesirable patterns on the scan of a 
printed original. When Descreen is turned on or off, a new preview 
scan starts and image adjustments are reset.
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On the Advanced menu, click Descreen. Select the option again to 
turn it off.

Resetting all adjustments

You can reset images to the optimal (default) values the scanning 
software chose for the image. Optimal values are based on the output 
type selected. Resetting removes all adjustments you have made 
except the output type, zoom level, or the selection area.
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Do one of the following:

l On the Edit menu, click Reset Tools.

l On the toolbar, click . 
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Completing the final scan

When you finish making changes, you need to complete the final scan 
by doing one of these tasks:

l Sending to a program. See this page.

l Returning the image to a program that supports TWAIN or the HP 
Scanjet Plug-in. See page 61.

l Saving to a file. See page 61.

l Printing. See page 63.

l Placing a scan on a website. See page 64.

l Preparing a scan for online viewing. See  page 64.

l Copying and pasting into another program. See page 65.

l Dragging-and-dropping into another program. See page 66.

l Dragging-and-dropping to the desktop or a folder. See page 66.

l Scanning to CD. See page 67.

When you do any of these procedures, the scanner performs a final 
scan including your changes before sending it to the program or printer 
you choose, copying the image, or completing any other function. 
Images are not automatically saved as files if you print them, send 
them to a another program, or copy and paste them into a file in 
another program. To use the scanned image again, be sure to save it. 
See "Saving to a file" on page 61.

Sending to a program

Once you finish viewing and changing the scanned image, you can 
perform a final scan and send it directly to a program such as e-mail. If 
the program you want is not available, save the image as a file and 
insert it into the destination program as you normally would.
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1 On the Scan menu, click Scan To. 
2 Choose a program from the list and click Scan. 
3 If the program you select accepts multipage files, you might be 

asked if you have more pages to scan to this file. Do one of the 
following:
l If this is a one-page item, click Done.
l If there are more pages of this item, load the next page in the 

scanner and click Scan on the computer. Repeat until all pages 
are scanned. Then, click Done.

The destination program opens and displays the scanned image.

Tip If you send text to Word or another word-processing 
program and the text appears inside a frame you do 
not want, double-click the frame border and click 
Remove Frame or a similar command. To prevent 
this from happening in the future, see "Setting 
preferences" on page 70.
Download from Www.Somanuals.com. All Manuals Search And Download.



Back to TOC Scanning from HP Precisionscan Pro 61
Returning the image to a program that supports 
TWAIN or the HP Scanjet Plug-in 

If you started the scan from a program that supports TWAIN or the 
HP Scanjet Plug-in, you can perform a final scan and return the image 
to that program using this procedure. For more information about 
scanning using TWAIN or the HP Scanjet Plug-in, see "Scanning from 
other programs" on page 74.
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Do one of the following:

l On the Scan menu, click Return Image To. 

l On the toolbar, click .

Saving to a file

Save scanned images as files when you want to use the images again 
later. For help deciding on which file type to use, see "List of file types" 
on page 62, or see "Tips for best image quality" on page 69. For 
definitions of File types, see the "Glossary" on page 123.
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1 Do one of the following:
l On the Scan menu, click Save As. 
l On the toolbar, click .

2 Select a file type. See "List of file types" on page 62.
3 Select a name and location for the file and click OK. 
4 If the Options button is available, more options are available for 

this file type. Click Options, change any options you want, and 
click OK.

The file type you need depends on how you will use the file. And, some 
file types are not available when certain output types are selected. 
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If you plan to process a scanned document with your optical character 
recognition (OCR) software, use the following settings:

l Resolution: 300 

l Output type: Black & White Bitmap

l Format: TIFF

Note: Selecting higher resolutions than 300 dpi will not 
increase OCR accuracy.
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Image file formats
l GIF. GIF is a compressed file format suitable for an image that will 

be used on the Web or on multiple platforms. Cannot be used with 
True Color output type.

l JPEG. JPEG is a compressed file format for images. Its strengths 
are small file sizes and speed. The trade-off for these advantages, 
though, is reduced image quality. Because each time an image is 
compressed with JPEG it loses a little of the image data, avoid 
compressing a file with JPEG more than once. JPEG is an 
appropriate file format for an image that will be used on the Web or 
on multiple platforms. 
You can save your JPEG file as a progressive JPEG. When used 
on a Web page, a progressive JPEG is initially sent as just every 
other line, with the remaining lines sent immediately after. This 
allows a (somewhat blurry) image to display sooner. Most people 
prefer this. JPEG can be used only with True Color and Grayscale 
output types.

l PNG. A compressed image file format that might replace GIF. Like 
GIF, PNG uses non-lossy compression, which means all the visual 
data is saved and restored when the file is decompressed. Unlike 
GIF, PNG can be used with True Color and Grayscale output types.

l PICT. Apple's proprietary image file format that is used by the 
Macintosh operating system. Designed for the screen, this format 
is best used for color images that will not be printed. Images saved 
as PICT files are smaller in size than images saved as a TIFF files.

l PDF. PDF is a format useful for text, photos, and drawings. Use 
Adobe Acrobat Reader to view PDF files. If no changes need to be 
made to the file, this file type is useful for sharing (as through 
e-mail) and filing because of its generally small file size. When 
using the Macintosh version of the scanning software, you can only 
create image-only PDF files; you cannot copy text from these files.

l TIFF. Usually created by scanners, TIFF files are widely accepted 
by programs that work with photographs and other images. A TIFF 
file is a bitmapped graphic (also called a raster graphic) and can be 
any resolution. TIFF image files can be used on multiple platforms.

l TIFF compressed. TIFF compressed files for images are smaller 
than standard TIFF files.

Text or text-and-image file formats 
l HTML. HTML is useful for text and graphics that will be viewed on 

the World Wide Web. When this format is selected for a scanned 
image containing both text and images, the text is converted to 
editable text and is saved as HTML, and the graphics are saved as 
GIF or JPEG files. 

l Rich Text. The RTF format can be used with a page that contains 
text or text and pictures. The formatting of text in an RTF file can 
usually be retained and then interpreted by other programs.

l Text. Use text file format for saving only the text in the selection 
area. Text will be editable, unformatted, ASCII text.
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Printing

The selection area is the part of the image that prints. If there is no 
selection border, the contents of the entire scanner bed, including 
blank areas, print. 
Printing does not save the image to the computer. Save the scanned 
image to a file to use the image later.
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1 Do one of the following:
l On the Scan menu, click Print.
l On the toolbar, click .

2 In the Print dialog box, select the options you want and click OK.
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Placing a scan on a website

You can share images with other people by scanning directly to the 
Web. People you know can view photos and other items by visiting 
your website, which will have its own address.
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1 Do one of the following:
l On the Scan menu, click Scan To.
l On the toolbar, click .

2 Select HP Share-to-Web from the list and click Scan.
3 Follow the instructions on the screen to finish posting the scanned 

image to the website.

Preparing a scan for online viewing

There are many website development applications, or HTML editors, 
available. These applications help you develop websites, and they 
support a variety of graphic file formats. However, not all Web 
browsers can display all the file formats that website development 
applications support. 
With the HP scanning software, you can scan your text or images, 
make adjustments to these scans, and then prepare them for the 
World Wide Web.
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To optimize a scan for a website, be sure to do the following:

l Save scans as GIF, JPEG, or PNG files. (Most Web browsers use 
these file formats.)

l For color images, choose the Web Palette output type. 

l Select a resolution of 72 dpi. (This resolution produces smaller file 
sizes than higher resolutions, and the images still look good on the 
computer screen.)

l Scale or resize your scanned image in the scanning software 
before inserting the image into your document.

Tip If you want to place a scan on a site other than an 
HP Share-to-Web website, save the scanned image 
as a file and then place the file on the site as you 
normally do. See "Preparing a scan for online 
viewing" on page 64.
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To scan an item for placement on a website, use one of the following 
methods:

l Drag-and-drop from the scanning software
If your website development application supports drag-and-drop, 
you can drag the image from the Preview area of the scanning 
software and drop it into the open Web page where you want it. 
Some website development applications have image editing 
capabilities if you want to adjust the image further. See the 
documentation that came with the website development application 
for more information.

l Save the image as a file
You can save the image as a file in the scanning software, and then 
insert that file into your website development application. 
Remember to save the file as a GIF, JPEG, or PNG file.

l Copy and paste the image
You can use the scanning software's Copy command or icon to 
copy the image to the Clipboard. In the website development 
application, use the Paste command to paste the image into the 
open Web page.

l Use the Scan To command
You can use the scanning software's Scan To command in the 
Scan menu to scan the image to a text file. Then, in the Save 
dialog box, select HTML in the Format pull-down menu.

Copying and pasting into another program

You can copy the scanned image to the Clipboard and then paste it 
into a file in the destination program. After the image is pasted, it 
becomes a part of the file.
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1 In the HP Precisionscan Pro software, do one of the following:
l On the Edit menu, click Copy.
l On the toolbar, click .

2 In the destination program, place the cursor where you want to 
insert the scanned image and click. 

3 Choose the Paste command in the program.
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Dragging-and-dropping into another program

You can drag-and-drop a scanned image into another program if that 
program supports drag-and-drop. If the program does not support 
drag-and-drop, the selection area returns to the scanning software 
window.
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1 Open a file in the destination program. Make sure you can see both 
the destination program and the HP Precisionscan Pro software.

2 In the HP Precisionscan Pro software, place the cursor over the 
scanned image.

3 While pressing OPTION, click inside the selection area and drag to 
the location in the destination program. Then, release the mouse 
button and OPTION. Wait for the scanner to perform a final scan of 
the image.

Dragging-and-dropping to the desktop or a folder 

Scanned images you drag-and-drop to the desktop or a folder become 
a Scrapbook picture clipping file. The bitmap file is given a generic 
name such as “picture clipping.” Subsequent images scanned to the 
desktop or that folder are numbered sequentially. 
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1 Make sure you can see both the HP Precisionscan Pro software 
and the desktop or the folder you want.

2 In the HP Precisionscan Pro software, place the cursor over the 
scanned image.

3 While pressing OPTION, click inside the selection area and drag to 
the desktop or folder. Then, release the mouse button and OPTION. 
Wait for the scanner to perform a final scan of the image.
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Scanning to CD

The Scan to CD function is a quick, convenient way to scan and save 
scanned items to a rewritable CD. This feature is a helpful shortcut for 
people who frequently archive or store scans on CDs. To scan to a CD, 
you must have CD-writer hardware installed and have a rewritable CD 
available.
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1 Start a new scan, and make any adjustments you want in using the 
scanning software.

2 In the HP Precisionscan Pro software, do one of the following:
l On the Scan menu, click Scan to CD.
l On the toolbar, click  (Scan to CD).
A Save As dialog box appears.

3 If a CD-writer drive is installed, this drive is automatically listed at 
the top of the dialog box. If you have created folders on your CD to 
organize images, select the desired folder in which to save the 
scan.

4 Type in a file name.
5 In the Format pull-down menu, select the file type. To change the 

file type, select a different file type in the drop-down list.
6 Click Save.
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Other features and tips

In this section, you can find information about:

l Which settings to use to get the best image quality. (See "Tips for 
best image quality" on page 69.)

l How to save a group of settings you use all the time and use them 
with future scans when you select them. (See "Saving settings" on 
page 69.)

l How to change the default settings the scanner uses to scan all 
items. (See "Setting preferences" on page 70.)

l How to start scanning from programs compliant with TWAIN or the 
HP Scanjet Plug-in. (See "Scanning from other programs" on 
page 74.)

l How to make scanned text editable. (See "Making scanned text 
editable" on page 75.)
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Tips for best image quality

Output type, resolution, file type, and values for other controls 
determine image quality and file size.
When you first scan an item, the scanner chooses the defaults for 
output type and resolution, and you do not need to change them. If you 
want to change these settings or want help choosing a file type, see:

l "To select an output type" on page 43

l "Changing resolution" on page 46

l "List of file types" on page 62

Saving settings 

You can save and name a group of settings that you frequently use for 
a particular purpose and apply them to items you scan in the future. 
For example, if you routinely e-mail pictures to someone, you can save 
the settings including the output type, resolution, and dimensions that 
you always use. The settings are automatically applied when you scan 
a picture and choose the group of settings.
Saved settings override the default settings and any changes you 
made up to that point. Any changes you make after that point are 
preserved.
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1 Make sure the scanned image whose settings you want to save is 
in the preview window and that you have adjusted any settings for 
the image.

2 On the Scan menu, point to Settings, and click Save. The settings 
for the current scanned image appear.

3 In the drop-down list at the bottom, type a name for these settings 
and click Save.
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1 Scan an item to the HP Precisionscan Pro software.
2 On the Scan menu, point to Settings, and click Load. 
3 Select the group of settings you want from the list at the bottom 

and click Load.

Tip For any image that will be printed, choose TIFF 
compressed as the file type to reduce the file size 
while maintaining quality. Also, many different 
programs recognize this file type.
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Setting preferences 

The preferences are the default settings for all scans performed. To 
change a setting only for the item currently being scanned see "Making 
optional adjustments, basic" on page 45 and "Making optional 
adjustments, advanced" on page 49.
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1 On the Scan menu, click Preferences.
2 Click the tab you want.
3 Change any settings you want. See the next sections for 

descriptions of options on tabs.
4 When finished, click OK.
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The Scanner tab of the Preferences dialog box controls these 
options.
Preview scan when the Scan To button is pushed 
When selected, a preview of the scan appears when you press the 
HP Scanning Software button on the scanner. When cleared, the 
software starts, but the scanner does not display a preview scan. Start 
a scan from the HP Precisionscan Pro software. 
Best Quality Scaling 
When selected, the highest quality scaling is applied to the final scan. 
When cleared, normal quality scaling is applied, making scanning 
faster.
Best Quality Sharpening 
When selected, the highest quality sharpening is applied to the final 
scan. When cleared, normal quality sharpening is applied, making 
scanning faster.
Maximum Pixel Depth 
When selected, the largest pixel bit depth is acquired from the scanner 
to produce the highest quality image. When cleared, less image data is 
processed, making scanning faster. 
Noise Reduction 
When selected, reduces the noise in the image caused by the scanner. 
When cleared, noise reduction is not applied, making scanning faster.
Descreening
When selected, a screened background image (such as a watermark) 
will be removed from the final scan. When cleared, any background 
image (such as a watermark) will be scanned as part of the image in 
the final scan.

sRGB Profile (Gamma 2.2)
When selected, the software uses the RGB profile from the screen to 
create the color in the final scan. This profile is also known as 
Gamma 2.2.

Note: Because Macintosh computers ship with Gamma 1.8, 
this option is not selected by default. When using this 
option, be sure to select sRGB in your monitor settings. 

Enable Scan Another Page Dialog 
When selected, a dialog box appears during final scanning that asks 
you if there are more pages of this item to scan. When cleared, the 
scanner assumes each job is only one page. Applies only to PDF, text, 
and RTF formats.
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The Selection Area tab controls the following preferences.
Automatically create selection area after a mouse click 
When selected, a selection area will be created around an area on 
which you click with the cursor. 
Automatically set the Output Type after selection 
When selected, the software automatically determines the output type 
of the area inside the selection border.
Automatically adjust exposure after selection 
When selected, the scanning software automatically changes the 
values in the Adjust Exposure or Adjust Black & White dialog boxes 
to the optimal values each time you create a new selection area. 
Values for an image do not change if you adjust the selection area 
while the Adjust Exposure or Adjust B&W Threshold dialog box is 
open.
When cleared, the scanning software does not automatically reset the 
controls in these two tools.
Automatically adjust color after selection 
When selected, the scanning software automatically changes the 
values in the Adjust Color dialog box to the optimal values each time 
you create a new selection area. Values never change if you create a 
different selection area while the Adjust Color dialog box is open.
When cleared, the scanning software does not automatically reset the 
controls.
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The Resolution tab controls the default resolution values available 
when you select Resolution on the Tools menu. 
Default values are already set, but you can add custom resolution 
values or delete values. The range of resolution is 12 to 999,999. Click 
Add to add a value. Or, select a value and click Delete to delete that 
value. 
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The Text tab of the Preferences dialog box controls the following 
preferences related to text output from the OCR program.
Text Output (format) 
l Framed text places the text from the page into frames and 

attempts to recreate the page formatting as closely as possible to 
the original. The program into which the text is placed must support 
this type of option.

l Flowed text eliminates columns and inserts any images in the text 
as closely as possible to where they were in the original. Flowed 
text is easier to edit.

Current OCR Language 
Allows you to choose the language the OCR program uses to check 
words it is processing in the item.
Image Output
Allows you to choose the output type the software uses for scanning 
images that appear on pages that include both images and text. This 
option is only available if you’ve selected Image and Text in the Edit 
Text tab on the Buttons tab of the HP Scanjet Controls dialog box.

l True Color. Scans images that appear on the page using the True 
Color output type. This option creates high-quality images. 
However, this option can increase the scanning time and can 
create final scans with large file sizes.

l Optimized Palette. Scans images that appear on the page using 
the Optimized Palette output type. This option decreases the time it 
takes the scanner to complete the scan and creates final scans 
with smaller file sizes. However, the quality of scanned images is 
lower.

See "Selecting output type" on page 43 for more information the output 
types available in the scanning software.
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The Controls tab of the Preferences dialog box controls the control 
range readout to use for scanning.
The control range sets the amount of tonal resolution per color 
available for correction in the Adjust Exposure command and Adjust 
Black & White command. Using a larger number of bits for the control 
range results in greater control of compensation for exposure or 
threshold correction.
Choose one of these options:

l 8-bit readout (0-255) — sets the controls to use 8 bits of tonal 
resolution per color

l 10-bit readout (0-1023) — sets the controls to use 10 bits of tonal 
resolution per color

l 12-bit readout (0-4095) — sets the controls to use 12 bits of tonal 
resolution per color

l 16-bit readout (0-65535) — sets the controls to use 16 bits of tonal 
resolution per color
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Scanning from other programs 

You can bring an image directly into an open file in one of your 
programs if the program supports TWAIN or the HP Scanjet Plug-in. 
Generally, the program is compliant if it has a command such as 
Acquire, Scan, or Import New Object. If you are unsure if the 
program is compliant or what the command is called, see the 
documentation for the program.
When scanning from within a program that supports TWAIN or the 
HP Scanjet Plug-in, the HP Precisionscan Pro software may start if the 
program allows it. If the HP Precisionscan Pro software starts, you can 
make changes to the image as you normally would. If not, the image 
returns to the program immediately.
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1 Start a scan from within the other program by choosing the 
Acquire (or similar) command. 

2 If the HP Precisionscan Pro software opens and displays the 
preview image, create a selection area. You can crop the scan (if 
necessary), select the output type, and make optional adjustments 
as you normally would. See the appropriate sections in this chapter 
for instructions.

3 When finished making changes to the scanned image, do one of 
the following to perform a final scan and place it in the program 
from which you started scanning:
l On the Scan menu, click Return Image To. 
l Click .

The image appears in the open program. You might have to reposition 
the image. 
If the image does not appear, the program might not accept the 
resolution or output type you selected. Rescan the image using the 
default settings the software sets for the image.

Tip If your program does not support TWAIN or the 
HP Scanjet Plug-in, you can try to copy and paste or 
drag-and-drop the image into the program. Or, save 
the image as a file and then place the file in the 
program.
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Making scanned text editable 

You can make text on a scanned image editable. The optical character 
recognition (OCR) program converts the text to be editable and then 
places it in a supported word-processing program. Depending on the 
capabilities of the word-processing program, graphics on a scanned 
image might be retained or discarded, or the OCR program might try to 
convert them and they will appear as random characters.
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1 Choose Scan To from the Scan menu.
2 Choose Text File from the Destination pull-down menu, and then 

click Scan.
3 Select a text or text-and-image file format in the Format pull-down 

menu, and then click Save. See "List of file types" on page 62.
4 If the program you select accepts multipage files, you might be 

asked if you have more pages to scan to this file. Do one of the 
following:
l If this is a one-page item, click Done.
l If there are more pages of this item, load the next page in the 

scanner and click Scan on the computer. Repeat until all pages 
are scanned. Then, click Done.

The OCR program opens and creates editable text from the scanned 
image.

Note: You can also save a scanned image and import the 
image into your OCR program. See "To save a scan for 
future processing in an OCR program" on page 61.

Tip If a block of text appears in Microsoft Word or 
another word-processing program inside a frame 
you do not want, double-click the frame border and 
click Remove Frame or a similar command. 
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OCR programs convert some text more accurately than other text. 
Because OCR technology is never perfect, proofread all converted text 
carefully to ensure the characters have been correctly interpreted.
These types of text convert most accurately:

l text in standard fonts

l text in 9-point font or larger

l crisp, clear text

l black text on a white background

These types of text might convert less accurately:

l text close to non-text elements, such as bullets, lines, or graphics

l text in spreadsheets, tables, or forms

l letters that have gaps, that “bleed” along their edges, or that touch 
other letters

l underlined text 

l text on colored paper

Handwriting cannot be converted.
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4 Using accessories

Some scanners support using the HP Scanjet Automatic Document 
Feeder (ADF) and the HP Scanjet Transparency Adapter (XPA) for 
scanning slides and negatives. (Some models only, see the "Front 
panel and accessories comparisons" on page 3.)
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Scanning from the ADF

You can scan multiple-page items quickly and easily using the ADF. 
When you use the ADF, you can scan to the HP Precisionscan Pro 
software or other destinations. For instructions about setting up the 
ADF, see the Setup and Support Guide. For information about 
preparing items for the ADF, see "Items for the ADF" on page 17.
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1 Place a stack of similarly sized originals in the document input tray, 
face up with the first page on top.

2 Adjust the paper guides to center the stack.

3 Do one of the following:
l Start the HP Precisionscan Pro software and follow the 

directions on the computer screen.
l Press a button on the front of the scanner.
If you start the scan from the HP Precisionscan Pro software or 
scan to the HP Precisionscan Pro software using the Scan To 
button ( ):
 a The ADF Scan dialog box opens and displays the current 

output type, resolution, and page size, which you can change. 
Or, you can click Load Settings and choose settings you have 
preset.

 b To scan the item to a file, click Scan. Or, to scan directly to a 
destination, click Scan To, select a destination, and click Scan.

If you start the scan from any scanner button except the Scan To 
button, follow the directions on the screen to complete the scan.
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Scanning from the XPA

You can scan slides or negatives using the XPA.

See the Setup and Support Guide for information about installing the 
XPA.
See "Items for the XPA" on page 18 for information about preparing 
items for the XPA.

Scanning slides 

To scan standard 35 mm slides, use the XPA light source and the 
positioning plate. When scanning fewer than three slides, you also 
need the slide light shield.
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1 With the XPA light source connected to its port on the scanner, 
restart the software. 

2 Place the positioning plate on the scanner glass so the arrow is in 
the upper right-hand corner. Push the positioning plate toward the 
top right corner.

3 Slide up to three slides into the slide holder on the bottom side of 
the XPA light source. The correct view of the picture should be 
facing outward, toward you.

Tip Do not use the XPA to scan a letter-size item, such 
as a presentation transparency. Place the 
transparent item on the scanner glass, place a white 
piece of paper on top, and scan as you normally 
would using the Scanner Glass command on the 
Scan menu.
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4 If you are scanning fewer than three slides, insert the slide light 
shield after you load your last slide.

5 Place the XPA light source into the positioning plate with slides 
facing down and the HP logo facing you.

6 From the HP Precisionscan Pro software, click the Scan menu, 
and select XPA (Slides).

7 Before making any changes, see "Making optional adjustments for 
slides or negatives" on page 83.

8 When you have finished using the XPA light source, on the Scan 
menu, click Scanner Glass. Disconnect the XPA light source if you 
want.

Tip The XPA light source also functions as a light table 
for viewing 35 mm slides. Insert slides as shown 
above. 
To keep the XPA light source on beyond the default 
period, select the Faster Scan setting in the HP 
Scanjet Controls control panel. See "Setting 
scanner lamp controls" on page 107. 

HP logo here
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Scanning negatives 

To scan 35 mm negatives, use the XPA light source, the positioning 
plate, and the negative holder. When scanning fewer than four 
negative frames, you also need the negative light shield.
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1 With the XPA light source connected to its port on the scanner, 
restart the software. 

2 Place the positioning plate on the scanner glass so the arrow is in 
the upper right-hand corner. Push the positioning plate toward the 
top right corner.

3 Slide the strip of negatives into the negative holder. If the negative 
strip curves, the curve should be facing out toward you.
CAUTION Negatives are easily damaged. Touch them only on 

the edges.

4 If you are scanning a strip of negatives with fewer than four frames, 
insert the negative light shield after the negative strip. See the icon 
on the negative holder for assistance.
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5 Slide the negative holder into the slide holder on the bottom side of 
the XPA light source.

6 Place the XPA light source into the positioning plate with negatives 
facing down and the HP logo facing you.

7 From the HP Precisionscan Pro software, click the Scan menu, 
and select XPA (Negatives).

8 Before making changes, see "Making optional adjustments for 
slides or negatives" on page 83.

9 When finished using the XPA light source, on the Scan menu, click 
Scanner Glass. Disconnect the XPA light source if you want.

HP logo here
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Making optional adjustments for slides or 
negatives

You can make optional adjustments to slides or negatives scanned 
using the XPA. Before deciding to make adjustments, create a 
selection area around one slide or negative so the software 
exposes it correctly. See "Cropping or selecting an area for final 
scan" on page 42.
If you choose to make adjustments to the image after you create a 
selection area, make most of them as you normally would, except for 
the following adjustments:

l Midtone. See "Adjusting midtones for slides or negatives" on 
page 83.

l Highlight. See "Adjusting highlights for slides or negatives" on 
page 84.

l Shadow. See "Adjusting shadows for slides or negatives" on 
page 84.

l RGB values and pixel color. See "Viewing RGB values and pixel 
color" on page 85.

Adjusting midtones for slides or negatives

You can adjust the overall lightness or darkness of the scanned image 
using the midtone setting. The range for the number in the Midtone 
field is -100 to 100.
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1 On the Advanced menu, click Adjust Exposure.
2 Do one of the following:

l Drag the Midtone slider up.
l Type a higher number in the Midtone field and press ENTER.
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1 On the Advanced menu, click Adjust Exposure.
2 Do one of the following:

l Drag the Midtone slider down.
l Type a lower number in the Midtone field and press ENTER.
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1 On the Advanced menu, click Adjust Exposure.
2 Click Auto to return the midtone, highlight, and shadow settings to 

the defaults for this slide or negative.
Tip See "Making optional adjustments, basic" on 

page 45 and "Making optional adjustments, 
advanced" on page 49 to make all adjustments 
except the ones mentioned above.

Tip To enlarge a slide or negative, see "Resizing (output 
dimensions)" on page 45.
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Adjusting highlights for slides or negatives

You can adjust highlights to lighten or darken the light areas. The 
range for the number in the Highlights field is -100 to 100.

��
����	��
����	��
�����

1 On the Advanced menu, click Adjust Exposure.
2 Do one of the following:

l Drag the Highlight slider up.
l Type a higher number in the Highlights field and press ENTER.
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1 On the Advanced menu, click Adjust Exposure.
2 Do one of the following:

l Drag the Highlight slider down.
l Type a lower number in the Highlights field and press ENTER.
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1 On the Advanced menu, click Adjust Exposure.
2 Click Auto to return the midtone, highlight, and shadow settings to 

the defaults for this slide or negative.

Adjusting shadows for slides or negatives

You can adjust shadows to lighten or darken the dark areas. The range 
for the number in the Shadows field is -100 to 100.
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1 On the Advanced menu, click Adjust Exposure.
2 Do one of the following:

l Drag the Shadow slider up.
l Type a higher number in the Shadows field and press ENTER.
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1 On the Advanced menu, click Adjust Exposure.
2 Do one of the following:

l Drag the Shadow slider down.
l Type a lower number in the Shadows field and press ENTER.
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1 On the Advanced menu, click Adjust Exposure.
2 Click Auto to return the midtone, highlight, and shadow settings to 

the defaults for this slide or negative.
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Viewing RGB values and pixel color

You can view the RGB values and pixel color for any spot in an image, 
color or grayscale, using the RGB Meter.
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1 On the Advanced menu, click Adjust Exposure.
2 Move the cursor over the area in the item for which you want to see 

the values. The values appear in the RGB area. A line appears in 
the histogram to show you where those pixels occur.
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5 Troubleshooting and maintaining

This section provides information for:

l Solving issues that might occur while using the scanner or 
HP scanning software, or issues with the appearance of scanned 
images. Start with "Checking the basics" on page 88. 

l Setting scanner lamp controls. See "Setting scanner lamp controls" 
on page 107.

l Clearing jams from the ADF. See "Clearing jams from the ADF" on 
page 108.

l Cleaning and maintaining the scanner and accessories. See 
"Cleaning and maintaining" on page 111.

For issues that occur during installation or the first time you scan, see 
the Setup and Support Guide.
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Checking the basics

If the scanner is not working, always perform these actions first.

l Check that the power cable is securely connected between the 
scanner and a live electrical outlet or surge protector.

l If the power cable is connected to a surge protector, make sure the 
surge protector is plugged into an outlet and turned on.

l Check that the interface cable is securely connected between the 
scanner and the computer.

Note: The scanner has ports for other interface connections, 
and a parallel cable might have been shipped in the box 
with the scanner. However, for Macintosh computers, 
use the universal serial bus (USB) cable.For more 
information, see the Setup and Support Guide. 

l Make sure the scanner is unlocked. Move the lock to the unlocked 
position. (Some models only, see "Front panel and accessories 
comparisons" on page 3.)

l Disconnect the power cable from the scanner and turn off the 
computer. After 30 seconds, reconnect the power cable to the 
scanner and then turn on the computer, in that order.

l If a program has frozen, close it. Press OPTION+  
(COMMAND KEY)+ESC, and then click Force Quit. 

If these steps did not resolve the issue, see "Starting troubleshooting" 
on page 89.
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Starting troubleshooting

Start here to find the information you need. Choose one of these 
general groups of issues, and then choose one of that group’s more 
specific issues.
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l A message is on the scanner or the computer. Follow the 
directions in the message to resolve the issue.

l There is no message. See "Resolving issues that did not 
generate messages" on page 90.

l There is an error message on the front panel liquid crystal 
display (LCD). See "Resolving scanner messages" on page 90.
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l Scanned images do not look good. See "Resolving issues with 
scanned images" on page 93.

l Printed copies do not look good. See "Resolving issues with 
printed copies" on page 96.

l Text on images is not editable. See "Resolving issues with 
editable text" on page 99.

l Slides or negatives do not look good. See "Resolving issues with 
slides and negatives" on page 98.
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See "Resolving issues sending to destinations" on page 101.
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l Pages are jammed in the ADF. See "Clearing jams from the 
ADF" on page 108.

l There is an issue with the ADF, other than pages jamming. See 
"Resolving issues with the ADF" on page 105.

l There is an issue with the XPA. See "Resolving issues with the 
XPA" on page 104.
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Resolving scanner messages

(Some models only, see "Front panel and accessories comparisons" 
on page 3.) If an error message appears on the 16-character front 
panel LCD on your scanner, look for the cause and solution in this 
section.

ADF Paper Jam
Pages are jammed in the ADF. See "Clearing jams from the ADF" 
on page 108 for information on clearing paper jams from the ADF.
Clear the paper jam. If the error message does not clear, unplug 
the scanner and plug it back in.

Error ##
The scanner reported an error during the self-test.
Unplug the scanner and plug it back in. If this error message is still 
on the scanner, contact HP support. Visit the HP support website 
at:
http://www.hp.com/go/support
See the Setup and Support Guide for phone contact information.

Scanner Locked
(Some models only, see the "Front panel and accessories 
comparisons" on page 3.) The scanner is not working because it is 
locked. Make sure the scanner is unlocked. Move the lock to the 
unlocked position. If the error message does not clear, unplug the 
scanner and plug it back in.

Resolving issues that did not generate 
messages

If the scanner or software is not working but no message appears, look 
for the cause and solution in this section.

Items you scanned previously are no longer on the computer.
The scanned image might not have been saved as a file. If you 
send an image directly to a destination, the scanned image is not 
saved on the computer. When you use the HP Precisionscan Pro 
software, use Save As to save the image to your computer.

The scanner lamp stays on.
The scanner lamp should time out and turn off automatically after a 
period of inactivity. 
l If you have recently used the scanner, wait a few more minutes. 
l If the scanner lamp is still on, you might have selected the 

Faster Scan setting. Check this setting on the Lamp tab in the 
HP Scanjet Controls control panel. See "Setting scanner lamp 
controls" on page 107.

l Press the Power Save button on the front panel of the scanner 
to immediately turn off the scanner lamp and the XPA light 
source (if connected). See "Using Power Save" on page 34.

l If you still encounter problems with the scanner lamp or the 
Power Save button, contact HP Customer Support.(See 
“Contacting HP Customer Support” in the Setup and Support 
Guide.) 
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I saved a scanned image to a file, but now I cannot open the file in 
the program I want.

You might have saved the file in a format the other program cannot 
use. Save the file in a different format the program can use. Look in 
the File Open or Import command for the program to see which 
file types it supports.

The scanner is not working.
One or more of these issues might be causing the problem:
l The scanner was not installed properly.
l The interface cable is not compatible with the scanner.
l If the scanner is emitting a grinding sound, the scanner is 

locked.
See "Checking the basics" on page 88 and the Setup and Support 
Guide.

The scanner does not scan right away.
If the scanner has not been used for a while, the scanner lamp has 
turned itself off. The lamp goes through a warm-up period after you 
start the software or press any scanner button. Wait for a few 
seconds for scanning to begin.

When I press a button on the scanner, the incorrect program opens.
Check which function is set to open when you press the button on 
the scanner. See "Configuring scanner buttons" on page 35.

When I choose Scan To on the scanner, the image does not appear 
in the software.

l A cable might be loose. Check that the interface cable is 
securely connected.

l You might have accidentally turned off the preview feature. 
Check this setting on the Scanner tab in the Preferences of the 
HP Precisionscan Pro software. See "Setting preferences" on 
page 70.

l (Some models only, see the "Front panel and accessories 
comparisons" on page 3.) Check that the HP Precisionscan Pro 
software is the program set to start when you press the Scan To 
button ( ).
1 Choose Control Panels from the Apple ( ) menu, and 

then choose HP Scanjet Controls from the submenu.
2 Click the Buttons tab in the HP Scanjet Controls dialog 

box, and then click the Scan To tab.
3 Make sure HP Precisionscan Pro is selected in the 

Destinations pull-down menu.

Scanner is scanning items very slowly.
l If you are scanning to edit text, the optical character recognition 

(OCR) program causes the scanner to scan more slowly, which 
is normal. Wait for the item to scan.

l Some default settings can cause the scanner to scan more 
slowly. Check the settings. See "Setting preferences" on 
page 70.

l The resolution might be set too high. Return to the default 
resolution. See "Changing resolution" on page 46.
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The correct menu items do not appear in the HP Precisionscan Pro 
software.

l If you used the ADF and then disconnected it, restart the 
software.

l If you were using the XPA, on the Scan menu, click Scanner 
Glass to scan from the glass again. 

l If you are trying to use the XPA and the XPA (Slides) or XPA 
(Negatives) commands are unavailable, restart the software 
while the XPA light source is connected to the scanner.

The scanner is making a loud clicking or grinding noise.
The scanner is locked. Move the lock to the unlocked position. 
(Some models only, see the "Front panel and accessories 
comparisons" on page 3.)

The scanner does not save multiple pages as a single file.
l If you are scanning from a scanner button, make sure the 

Prompt for Another Page option is selected in the HP Scanjet 
Controls control panel. See "Configuring scanner buttons" on 
page 35.

l If you are scanning from the HP Precisionscan Pro software, 
make sure the Enable Scan Another Page Dialog option is 
selected in the HP Precisionscan Pro Preferences dialog box. 
See "Setting preferences" on page 70.
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Resolving image-quality issues

This section contains information for resolving image-quality issues, 
whether you scanned using the scanner glass, the ADF, or the XPA.

l “Resolving issues with scanned images.” See this page.

l "Resolving issues with printed copies" on page 96. 

l "Resolving issues with slides and negatives" on page 98. 

Resolving issues with scanned images

This section contains solutions to issues that affect all scanned 
images, regardless of whether you used the scanner glass or the ADF. 
If you were printing, see also "Resolving issues with printed copies" on 
page 96.

Scanned images are too light or too dark.

The original image might be very light or dark or be printed on 
colored paper. Adjust the midtone, highlight, and shadow settings 
from the HP Precisionscan Pro software. See "Scanning from HP 
Precisionscan Pro" on page 39.

Scanned images have black dots or streaks in top and bottom 
margins. 

There might be ink, glue, correction fluid, or some other substance 
on the scanner glass. Clean the scanner glass. See "Cleaning the 
scanner glass" on page 111.

Scanned images have unwanted lines through them.

l The scanner glass might be dirty. Clean the glass. See 
"Cleaning the scanner glass" on page 111.

l If you are using the ADF, the ADF glass might be dirty or 
scratched. Clean the ADF glass. See "Cleaning the ADF glass" 
on page 112.
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Scanned image is not clear.

l The resolution, sharpening, or midtone, highlight, and shadow 
settings might need to be adjusted before scanning. See 
"Scanning from HP Precisionscan Pro" on page 39.

l The original might be on colored paper. If the original was 
printed on a colored paper, including brown recycled paper, the 
image or text might not be clear. Try adjusting the resolution and 
midtone, highlight, and shadow settings from the 
HP Precisionscan Pro software. See "Scanning from HP 
Precisionscan Pro" on page 39.

The image is completely black or completely white.
The item might not be placed correctly on the scanner glass or in 
the ADF. Make sure that the item you are trying to scan is placed 
face down on the glass, or face up in the ADF.

Colors in the scanned image are different from the original item.
Scanners, monitors, printers, and different operating systems 
interpret color differently. Use the hue and saturation settings in the 
HP Precisionscan Pro software to adjust the colors.

In the HP Precisionscan Pro software, all of the image scanned when 
I only wanted part, or vice versa.

The selection area might not be selected correctly. Make sure the 
selection border is surrounding the area you want in the final scan.

Scanned images are crooked.
The item might have been placed crookedly or shifted when you 
closed the lid. Straighten the original on the scanner glass and 
scan again.

I thought I made the image smaller or larger before the final scan in 
the HP Precisionscan Pro software, but it is still the same size as the 
original.

You might have zoomed in or out, which does not change the size 
of the image. Change the output size. See "Resizing (output 
dimensions)" on page 45.

An original photo was fuzzy, and the scanned image looks even 
worse.

The sharpening level needs to be increased. In the 
HP Precisionscan Pro software, adjust the sharpening. See 
"Sharpening an image" on page 48.
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Scanned images are grainy, jagged, or fuzzy.
l You resized the image in a program other than the 

HP Precisionscan Pro software. Resize the image in the 
HP Precisionscan Pro software before you send it to the other 
program. (See "Resizing (output dimensions)" on page 45.) 

l In the HP Precisionscan Pro software, the resolution is set too 
low. Set the resolution to a higher number, or return to the 
default setting. See "Changing resolution" on page 46.

l In the HP Precisionscan Pro software, too much or too little 
sharpening was applied. Adjust the sharpening. See 
"Sharpening an image" on page 48.

An original photo had marks, flaws, or scratches, and the scanned 
image looks even worse in the HP Precisionscan Pro software.

l You sharpened the image manually. Return to the default 
setting. See "Sharpening an image" on page 48.

l Best Quality Sharpening is selected. Check the setting. See 
"Setting preferences" on page 70.

I set the image to a higher resolution in the HP Precisionscan Pro 
software, but the output quality is no better.

l Setting the resolution to a higher number does not necessarily 
improve quality. The software sets the resolution automatically 
based on the type of item you scanned. Keep or return to the 
default. See "Changing resolution" on page 46 or "Tips for best 
image quality" on page 69 for guidelines.

l If you sent the image to another program, the program might not 
support the resolution you set in the HP Precisionscan Pro 
software. Determine the setting the program uses and set the 
resolution in the HP Precisionscan Pro software to that 
resolution.

Images scanned from the HP Precisionscan Pro software are larger 
than the original when viewed or printed from another program.

The other program did not accept the image size information. Scan 
the image at a lower resolution. When you scan at a resolution the 
program accepts, it will display or print the image at the correct 
size.

The image is too big or too small.
In the HP Precisionscan Pro software, set the physical output 
dimensions in the Resize dialog box. See "Resizing (output 
dimensions)" on page 45.

When I try to scan to the Web from the HP Precisionscan Pro 
software, the image is too large or does not look good on screen.

Scan settings for this image might be set incorrectly. See "Tips for 
best image quality" on page 69.
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Resolving issues with printed copies

Use this section to help resolve issues with printed pages.

Parts of the page around the edges are not printing.

Printers cannot print right up to the edge of the paper. To get the 
image to fit inside the printable area, you must slightly reduce the 
size of the image in the HP Precisionscan Pro software and then 
reprint the image.

Copies are too light. 

l If you are copying an item printed on colored paper, there might 
not be enough contrast between the ink and paper colors. Adjust 
the highlights, shadows, midtones, and resolution settings from 
the HP Precisionscan Pro software. See "Scanning from HP 
Precisionscan Pro" on page 39. Or, adjust the contrast from the 
HP Scanjet Copy Utility. Also, if possible for text, use originals 
printed with black ink on white paper.

l The printer might be out of toner or ink. Print a different file from 
another program to the printer to see if the issue lies with the 
printer.

Vertical white stripes appear on the page. 

l The printer might be out of toner or ink. Print a different file from 
another program to the printer to see if the issue lies with the 
printer.

l The scanner internal mirror might be contaminated. Contact the 
Customer Service Center for service.

The bottom of the printed page is blank, or part of a graphic is cut 
off. 

The page might be too complex. (The printer does not have 
enough memory to process the page.) Set the resolution of the 
image to 300 dpi or less in the HP Precisionscan Pro software. See 
"Changing resolution" on page 46.
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Colors in printed images are incorrect.
The output type or printer settings might not be correct. Choose a 
different output type and print again. Check the printer settings. If it 
is a color printer, check if the printer is out of ink or toner. 

Scanned images are jagged or fuzzy.
l The output type in the HP Precisionscan Pro software might not 

be set correctly. Set the output type to True Color or Grayscale. 
See "Selecting output type" on page 43.

l If you placed the image in a file in another program, resized the 
image, and are printing from that program, resizing the image in 
the program probably caused the issue. Resize the image in the 
HP Precisionscan Pro software before placing it in a file in 
another program. See "Resizing (output dimensions)" on 
page 45.

l If the original image was fuzzy and you enlarged it, the fuzziness 
becomes more obvious. 
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Resolving issues with slides and negatives 

Use the following section to help resolve issues with slides or 
negatives scanned using the XPA. All actions must be performed in the 
HP Precisionscan Pro software, because you must scan slides or 
negatives using this software. See also "Resolving issues with the 
XPA" on page 104.

I tried to enlarge a scanned image of a slide, but the image 
remained the same size.

You might have used the Zoom In command, which only changes 
the view on the screen. Use the Resize command to change the 
size of the final scanned image. See "Resizing (output 
dimensions)" on page 45.

The colors are incorrect, or the image is too light or too dark.
l The software might be setting exposure for the entire area 

instead of one slide or negative. Create a selection area around 
the slide or negative you want to use to ensure it is exposed 
correctly. 

l The positioning plate is not placed completely on the scanner 
glass. Make sure the positioning plate is completely on the 
scanner glass.

l If you are scanning fewer than three slides with the XPA, make 
sure to use the slide light shield to cover the remaining area in 
the slide holder. This ensures that no extra light affects the scan.

l If you are scanning fewer than four negative frames with the 
XPA, make sure to use the negative light shield to cover the 
remaining area in the negative holder. This ensures that no extra 
light affects the scan.

The scanned image shows a colored tint, usually pink. 
The image was probably scanned without the XPA, or the 
positioning plate and XPA light source were placed incorrectly on 
the scanner bed. For the steps for scanning 35 mm slides or 
negatives, see "Scanning from the XPA" on page 79. 

Scanned images appear as a box with multi-colored vertical lines or 
as a dashed box with an arrow surrounding the area.

The positioning plate might be placed incorrectly on the scanner 
bed. Place the positioning plate on the scanner glass so the 
Hewlett-Packard logo is at the bottom right.

The scanned image is black even though the light on the XPA light 
source is on.

l The positioning plate might be placed incorrectly on the scanner 
bed. Place the positioning plate on the scanner glass so the 
Hewlett-Packard logo is at the bottom right. 

l Check the Adjust Exposure command in the Advanced menu.

There are streaks in the scanned image.
l Check the original slide or negative for damage.
l The XPA may be broken, and service may be required.

The scans are dark.
The bulb in the XPA light source might be broken or not working. If 
the bulb is broken, service is required.
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Resolving issues with editable text

This section contains resolutions to issues that might occur when you 
are trying to make text editable.

Scanned text is not editable.
l If you used the HP Precisionscan Pro software, send the 

scanned image to a text or text-and-image file format. See 
"Making scanned text editable" on page 75.

l If you used the HP Precisionscan Pro software, you sent the 
scan to an image file or saved the scan using an image output 
type. Send the scan to a text file. See "List of file types" on 
page 62. Or open the image file from the OCR software. See the 
documentation for the OCR software.

Scanned text is editable in some programs but not in others.
Some programs accept only image formats and do not allow text. 
Make sure the program accepts editable text.

Incorrect characters appear in the text that was converted using the 
OCR software.

The accuracy of the OCR program depends on the program having 
the correct settings on the quality of the original item. To obtain the 
best possible results, choose the scan setting for text, and process 
only crisp, clear text. See "What to expect from OCR programs" on 
page 76.

Converted text does not appear in my word-processing program.
Do one of the following:
l If you used the HP Precisionscan Pro software, send the 

scanned image to a text or text-and-image file format. See 
"Making scanned text editable" on page 75.

l Cut and paste the text into the program you want. If the text is 
still not editable, work with the text as an image or retype it.

I do not know how to process text using a different OCR program.
Do one of the following:
l Scan the item from the OCR program using TWAIN or the HP 

Scanjet Plug-in. See "Scanning from other programs" on 
page 74.

l Scan the item to the HP Precisionscan Pro software, save the 
scanned image as an image file, and open the file in the other 
OCR program.

l Scan to the HP Precisionscan Pro software. Then, on the Scan 
menu, click Scan To and choose the other OCR program. 
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The converted text did not retain font size and style when the text was 
placed in a word-processing program.

Word-processing programs cannot always accept the original 
formatting of the scanned text. Reformat the text in the word-
processing program.

Converted text appeared in the word-processing program without its 
formatting and I wanted it, or vice versa.

Even if you want to retain the formatting and you have the setting 
set correctly, the receiving word-processing program cannot 
always accept the formatting. Reformat text in the word-processing 
program.
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Resolving issues sending to destinations

Use this section to resolve issues sending images to destinations. Not 
all functions are available on all scanners.

When I choose E-mail on the scanner, scanned images do not 
automatically appear in a new e-mail message.

The e-mail program is Web-based or might not be supported. Save 
the scanned image as a file and attach it to your e-mail message 
as you normally do.

When I choose E-mail on the scanner, the scanned image attaches as 
a bitmap, but it contains text I want the recipient to be able to edit.

To make text editable for a recipient, make sure the correct output 
type is selected in the HP Scanjet Controls control panel. 

1 Choose Control Panels from the Apple ( ) menu, and then 
choose HP Scanjet Controls from the submenu.

2 Click the Buttons tab in the HP Scanjet Controls dialog box, 
and then click the E-mail tab.

3 Select the e-mail program, and then click either Text or Text 
and Image.

4 Close the HP Scanjet Controls dialog box.
Or, save the scanned image as a file and attach it to a message as 
you normally do.

When I press the E-mail button on the scanner, the incorrect e-mail 
program opens.

Check which e-mail program is set to open when you press the 
E-mail button ( ) on the scanner. See "Changing settings for 
buttons" on page 35.

When printing copies from the scanner or the HP Scanjet Copy 
Utility, I cannot choose the printer I want.

Do one of the following:
l Make sure the printer is set up and configured correctly in the 

Chooser. (For more information about using the Chooser, see 
the Mac OS Help on your computer.)

l Scan the item to the HP Precisionscan Pro software and print 
from there.

When printing copies, I can only make multiple copies of one page 
at a time (I cannot collate copy).

Even if you are using an ADF, each page is treated as a separate 
job. You can make multiple copies of one page, but not multiple 
copies of different pages and collate them.
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When I choose the Scan To button on the scanner, the image does 
not appear in the software.

l A cable might be loose. Check that the interface cable is 
securely connected.

l You might have accidentally turned off the preview feature. 
Check this setting on the Scanner tab in the Preferences of the 
HP Precisionscan Pro software. See "Setting preferences" on 
page 70.

l Check that the HP Precisionscan Pro software is the program 
set to start when you press the Scan To button ( ).
1 Choose Control Panels from the Apple ( ) menu, and 

then choose HP Scanjet Controls from the submenu.
2 Click the Buttons tab in the HP Scanjet Controls dialog 

box, and then click the Scan To tab.
3 Make sure HP Precisionscan Pro is selected in the 

Destinations pull-down menu.

I tried to scan an image into an existing file, but the scanned image 
appeared in a new file instead.

Some programs only allow scanned images to be placed into new 
files. Cut and paste the image into the file you want. Or, save the 
scanned image as a file and import it into the other program.

When I try to send a scanned image using the Scan To command on 
the Scan menu of the HP Precisionscan Pro software, the program I 
want does not appear. 

The HP Precisionscan Pro software might not recognize the 
program as a destination. Do one of the following:
l Rebuild the desktop on the computer. To rebuild the desktop, 

press  (COMMAND KEY)+OPTION while restarting the computer. 
(For more information, see the Mac OS Help on your computer.)

l Save the scanned image in a file type the other program uses, 
and then open the file in the other program.

l Copy and paste or drag-and-drop the image into the other 
program.

l Reinstall the program that is not being recognized. This might 
allow the HP Precisionscan Pro software to recognize it.
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I want to start scanning from another program, such as my word-
processing program, so I can bring an image into my open file, but I 
cannot start the scan. 

The other program must support TWAIN or the HP Scanjet Plug-in. 
If you cannot find a command such as Acquire or Insert, check the 
documentation for the program to see if it is compliant. 
If the program supports the HP Scanjet Plug-in and you cannot 
start a scan from another program, reinstall the HP Scanjet Plug-in:
1 Quit the program with which you want to use the plug-in. 
2 Insert the HP Scanning Software CD into your computer's CD-

ROM drive. The HP Scanning Software window appears. (If the 
HP Scanning Software window does not appear, double-click 
the icon for the HP Scanning Software CD.)

3 In the HP Scanning Software window, double-click the HP 
Scanjet Plug-in folder.

4 Drag the HP Scanjet Plug-in (which is named HPScanjet) to the 
appropriate location for the program with which you want to use 
the plug-in. (Many programs have a specific folder for plug-ins. 
For information about where to place the plug-in, see the 
documentation provided with the program.) 

5 Start the program with which you want to use the plug-in. 
If the program does not support TWAIN or the HP Scanjet Plug-in, 
do one of the following in the HP Precisionscan Pro software:
l Save the scanned image as a file and then insert the file into the 

other program. 
l Click Scan To from the Scan menu, and choose a program.
l Copy and paste or drag-and-drop the image into the other 

program.

I am trying to return a scanned image to a program that supports 
TWAIN or the HP Scanjet Plug-in, but the image will not appear.

The program that supports TWAIN or the HP Scanjet Plug-in might 
not accept the resolution or output type you selected. Rescan the 
image using the default settings the HP Precisionscan Pro 
software sets for the image.

I do not see the destinations I want when I use the Select Destination 
button next to the Scan To button. 

(Some models only, see the "Front panel and accessories 
comparisons" on page 3.)
Not all destinations appear in the scanner’s destination list. For 
example, printers, e-mail programs, and saving to a file are not 
included. The list is also limited to the first 18 destinations found by 
the HP scanning software. You can access additional destinations 
through the HP Precisionscan Pro software. See "To send to a 
program" on page 60 for more information, or do one of the 
following.
l Update the destinations for your scanner buttons. See "To 

change settings for Speed Destinations" on page 36 for steps.
l Unplug the scanner and plug it back in.
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Resolving issues with accessories

This section contains information for resolving issues when you are 
using the XPA or ADF. 

Resolving issues with the XPA

This section contains issues that might occur when you are using the 
XPA. See also "Resolving issues with slides and negatives" on 
page 98.

The XPA is not working at all.
The XPA cable might not be connected correctly. Make sure the 
XPA cable is connected securely to the XPA port on the scanner.

When using the XPA, I cannot choose XPA (Slides) or XPA 
(Negatives) on the Scan menu.

l The XPA cable might not be connected correctly. Make sure the 
XPA cable is connected securely to the XPA port on the scanner.

l If you connected the XPA light source while the HP 
Precisionscan Pro software was running, restart the software. 
Doing so allows the software to detect the XPA.

When using the XPA, I cannot scan using the scanner buttons. 
The XPA is not designed to work with the scanner buttons. Use the 
HP Precisionscan Pro software when using the XPA.

There is no light or only a dim light in the transparency adapter after 
checking XPA (Slides) or XPA (Negatives) in the Scan menu.

l Make sure you have selected XPA (Slides) or XPA (Negatives) 
from the Scan menu in the HP Precisionscan Pro software. If 
these two commands are unavailable, restart the software while 
the XPA light source is connected to the scanner.

l The bulb in the XPA light source might be broken or not working. 
With the XPA light source connected to the scanner, hold the 
XPA light source up and look for illumination. If the bulb is 
broken, service is required.
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Resolving issues with the ADF

This section contains issues that might occur when you are using the 
automatic document feeder (ADF).

The ADF is feeding multiple sheets, skewing pages, or jamming 
frequently. 

l If the pages look like they are skewing as they feed into the ADF, 
check the resulting scanned images in the software to ensure 
they are not skewed.

l The item might not be placed correctly. Straighten the item and 
adjust the guides to center the stack.

l The maximum number of pages the ADF input tray and output 
bin can hold is 25, depending on the type of media being loaded. 
Make sure to load only 25 or fewer pages in the input tray, and 
remove pages from the output bin if they are stacking up to a pile 
of more than 25.

l The item loaded might not meet the specifications for the ADF. 
Make sure the type of media being loaded meets required 
specifications. See "Items for the ADF" on page 17.

When using the ADF, the scanner does not feed the item at all.
The hatch might not be securely latched. Open the hatch, and then 
close it, pressing firmly. See "To clear jams at the start of a page" 
on page 108 for illustrations.

An item loaded in the ADF keeps jamming.
l The item does not meet the guidelines for the ADF. See "Items 

for the ADF" on page 17.
l The item might have something on it. Make sure you have 

removed anything such as staples and self-adhesive notes on 
the item. See "Selecting and preparing items" on page 17.

l The item is too small. The ADF can handle items as small as 
88.9 by 127 mm (3.5 by 5.0 inches). Use the glass to scan.

l The item is too large. The ADF can handle items as large as 216 
by 355.6 mm (8.5 by 14 inches). Use the glass to scan the item 
in sections.
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The bottom of the scanned image is cut off.
l The ADF can handle items up to 355.6 mm (14 inches) long. If 

the item is longer, scan it in sections on the glass. If the item is 
the correct length, choose the correct page size setting in the 
ADF dialog box prompt before scanning.

l If sent to a printer, the item might be too complex (require too 
much memory) for the printer to process. If possible, choose a 
printer with more memory. Or, select a lower resolution or 
different output type, like black and white or grayscale.

l If you are scanning from the scanner buttons, make sure the 
correct page size for the ADF is selected in the HP Scanjet 
Controls control panel:
1 Choose Control Panels from the Apple ( ) menu, and 

then choose HP Scanjet Controls from the submenu.
2 Click the Buttons tab in the HP Scanjet Controls dialog 

box, and then click the tab for the scanner button you are 
using. 

3 In the ADF Page Size section of the dialog box, select the 
setting that corresponds to the pages you are using with the 
ADF.

4 Close the HP Scanjet Controls dialog box. 

Note: If you use a different scanner button with the ADF and 
encounter this problem again, follow these steps to set 
the correct page size for that button.

After starting a scan from the Copy button using the ADF, the 
scanned image is reduced on the printed page and extra space 
appears around the scanned image.

When using the Copy button, the ADF page size settings are not 
sent automatically to the printer. Set the page size in the Page 
Setup dialog box on the computer:
1 In the Application menu (located in the upper-right corner of 

the screen), choose Finder.
2 In the File menu, choose Page Setup. 
3 Choose the appropriate page size in the Paper pull-down 

menu.
4 Click OK.
For more information about setting the page size, see the Mac OS 
Help on your computer.
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Setting scanner lamp controls

You can set the scanner lamp to use either Energy Save or Faster 
Scan. These scanner lamp controls are available in the 
HP Scanjet Controls control panel.

Energy Save

While using Energy Save, the scanner lamp stays on as long as the 
software is running and might stay on for a while after the software is 
closed. However, after about ten minutes, the scanner lamp turns off. 
Because the scanner lamp turns off, the scanner conserves energy 
when Energy Save is enabled. (Energy Save is the default setting for 
the scanner.)
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1 Choose Control Panels from the Apple ( ) menu, and then 
choose HP Scanjet Controls from the submenu.

2 In the HP Scanjet Controls dialog box, click the Lamp tab.
3 Click Energy Save.
4 When finished, close the HP Scanjet Controls dialog box.

Faster Scan

After the scanner lamp has turned off, it must warm up again before 
the scanner can begin scanning. (This warm-up process takes about 
30 seconds.) As a result, the time it takes to scan an item immediately 
after the scanner lamp turns on is longer than the time it takes to scan 
subsequent items. 
To help prevent scanning delays caused while the scanner lamp is 
warming up, you can enable Faster Scan. This setting allows you to 
set a time (such as the beginning of your business day) when the 
scanner lamp automatically turns on. The scanner lamp stays on for 
ten hours and then turns off.
Because the scanner lamp stays on, even if you are not using the 
scanner or the software, the scanner uses more energy when Faster 
Scan is enabled.
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1 Choose Control Panels from the Apple ( ) menu, and then 
choose HP Scanjet Controls from the submenu.

2 In the HP Scanjet Controls dialog box, click the Lamp tab.
3 Click Faster Scan.
4 In the Select Time text box, type the time when you want the 

scanner lamp to turn on daily.
5 When finished, close the HP Scanjet Controls dialog box.
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Clearing jams from the ADF 

Pages can jam at the beginning or the end of a page. Use the 
appropriate procedure below to clear the jam and continue.
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1 Raise the hatch.

2 Lift the large green tab (located to the left of the roller) and gently 
remove the jammed page.

3 If the item cannot be easily removed, lift the two green tabs located 
behind the rollers and gently remove the green paper lead as 
shown. 

Note: Using force to remove the page might cause damage to 
your originals. If the majority of the paper is already 
through the main roller, use the procedure to clear jams 
at the end of a page.
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4 Remove the jammed item from the ADF and replace the paper 
lead.

5 Close the hatch. Press down firmly until you hear a click.

6 Restack all pages and reload them into the ADF.

7 On the ADF prompt on the computer, reselect any settings you had 
changed and click Scan To or Scan again.
Download from Www.Somanuals.com. All Manuals Search And Download.



110 Troubleshooting and maintaining Back to TOC
��
�����
.��
�	
	��
���
��
�
����


1 Remove any pages from the ADF input tray.
2 Remove the input tray from the ADF. 

3 Gently pull the paper out of the ADF in the feeding direction 
(towards you). 

4 If you still cannot remove the paper from the ADF, lift the ADF lid to 
its fully open position, loosen the jammed paper from the roller at 
the rear of the ADF lid, and pull it gently from the ADF. 

5 When you have successfully cleared the jam, attach the input tray 
and close the hatch. Press down firmly on both sides until you hear 
a click.

6 Restack all pages and reload them into the ADF. 
7 On the ADF prompt on the computer, reselect any settings you had 

changed and click Scan To or Scan again.
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Cleaning and maintaining

Periodically, the scanner and accessories might need to be cleaned or 
to have maintenance, especially if you are seeing marks or smudges 
on scanned images. 

Cleaning the scanner glass

You might need to clean the scanner glass if the ink on items you are 
scanning can be smudged with your hand or items have excessive 
amounts of dust or dirt on them. You might also need to clean the 
scanner glass if there are smudges or other marks on scanned 
images.
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1 Disconnect the power cable from the scanner.
2 Open the scanner lid.
3 Clean the glass using a soft, lint-free cloth sprayed with a mild 

glass cleaner.
CAUTION Only use glass cleaner. Avoid abrasives, acetone, 

benzene, and carbon tetrachloride, all of which can 
damage the scanner glass. Avoid isopropyl alcohol 
because it can leave streaks on the glass.

4 Dry the scanner glass with a dry, soft, lint-free cloth.
5 When finished, reconnect the power cable to the scanner.
Fingerprints or smudges on the underside of the glass do not affect the 
appearance of scanned images because this area of the glass is 
outside the focal point of the scanner. 
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Cleaning the XPA 

(Some models only, see "Front panel and accessories comparisons" 
on page 3.) Clean the XPA with a dry, soft cloth. If necessary, spray the 
cloth with window cleaner or isopropyl alcohol.

Cleaning the ADF glass

(Some models only, see "Front panel and accessories comparisons" 
on page 3.) You must clean the ADF glass to maintain high-quality 
scanning.
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1 Disconnect the power cable from the scanner.
2 Open the scanner lid and locate the ADF glass area on the 

scanner bed.

3 Clean the glass using a soft, lint-free cloth sprayed with a mild 
glass cleaner.
CAUTION Only use glass cleaner. Avoid abrasives, acetone, 

benzene, and carbon tetrachloride, all of which can 
damage the scanner glass. Avoid isopropyl alcohol 
because it can leave streaks on the glass.

4 Dry the scanner glass with a dry, soft, lint-free cloth.
5 When finished, reconnect the power cable to the scanner.
Fingerprints or smudges on the underside of the glass do not affect the 
appearance of scanned images because this area of the glass is 
outside the focal point of the scanner. 
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Uninstalling the software

The Uninstall option of the Installer allows you to remove the scanning 
software from your computer.

��
�����	���
	��
���	����


1 Unplug the scanner, and then restart the computer.

Note: If you do not unplug the scanner and restart the 
computer before you uninstall the software, some files 
are not removed from your computer during the 
uninstallation.

2 Insert the HP Scanning Software CD into your computer's CD-
ROM drive. The HP Scanning Software window appears. (If the HP 
Scanning Software window does not appear, double-click the icon 
for the HP Scanning Software CD.)

3 Double-click the HP Scanning Software Installer, and then follow 
the instructions on the screen.

4 When the main installation dialog box appears, select Uninstall 
from the pull-down menu (located in the upper-left part of the dialog 
box).

5 Click Uninstall.
6 Follow the instructions on screen.
7 After the uninstall finishes, quit the HP Scanning Software Installer.

Other resources, support, and 
specifications

The Setup and Support Guide contains information about these topics:

l Setup instructions and troubleshooting. Find setup instructions 
and troubleshooting information for issues that can arise when you 
install the scanner.

l Resources. Discover websites and other tools that contain 
scanning tips, updated drivers, and the latest information about 
your HP scanner.

l Support. Locate the contact information for your region if you need 
to contact HP.

l Warranty and Specifications. See this topic for the warranty and 
product and regulatory information.

The Setup and Support Guide is located on the CD in the folder for 
your language, or on your computer in the HP Scanning Software 
folder. 
Also, see the HP PrecisionScan Pro Read Me file for late-breaking 
information about the HP Precisionscan Pro software. This file is 
located in the same folder as the Setup and Support Guide.
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A Using software commands and controls

This section contains information for using the shortcuts, toolbars, and 
cursors in the HP Precisionscan Pro software. 
The HP Precisionscan Pro contains keyboard shortcuts and toolbars to 
give you quick access to software commands. The Info bar provides 
information about the scanned image, and the context-sensitive 
cursors provide information on the type of activity you can perform in 
the scanning software.
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Using keyboard shortcuts and the menus

This section summarizes the menus and commands in the 
HP Precisionscan Pro software that you can select using the 
keyboard. 

About HP Precisionscan 
Pro

View information about the program, 
version, and copyright.

Apple ( ) menu

New Scan +N Start (preview) a new scan.

Scan To... +T Scan and send to a destination, such as 
e-mail

Scan to CD Save scanned photos or documents on a 
CD-writer drive.

Return Image To When using TWAIN or the HP Scanjet 
Plug-in, return the scanned image to the 
other program.

Save As... +S Save the selection area as a file.

Page Setup... Change how printed pages are set up, 
including page orientation and paper size.

Print... +P Scan and print the selection area.

Scanner Glass
XPA (Slides)
XPA (Negatives)

Select the source from which to scan. Only 
one can be selected. 

Settings
Save... Save settings.
Load... Load (use) settings.

Preferences... Change scanning default preferences.
Quit +Q Close the HP Precisionscan Pro software.

Scan
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Reset Tools +Z Return all settings except output type to 
the defaults for this image.

Copy +C Scan and place the selection area on 
the Clipboard.

Select All +A Select the entire scanner glass 
(including blank space).

Unselect All Remove the selection border.

Zoom In Zoom in on the selection area.

Zoom Out Zoom out to the original view.

Edit

View

True Color

Choose the output type. Only one can 
be selected. 

Optimized Palette

Web Palette

System Palette

Spot Color

Grayscale 

Black & White Bitmap

Automatically Set Type Allow the software to select the output 
type based on the contents of selection 
area.

Rotate Left 90° Rotate the image counterclockwise by 
90 degrees.

Rotate Right 90° Rotate the image clockwise by 90 
degrees.

Mirror Reverse the image side-to-side.

Resize Resize the selection area. This 
changes the output file size also.

Change Resolution Change the resolution of the final 
scanned image.

Sharpen Adjust the sharpening.

Output Type

Tools
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Adjust Color Adjust colors (hue) and their intensity 
(saturation).

Adjust Exposure Adjust the contrast (midtones), detail in 
light areas (highlights), and detail in 
dark areas (shadows).

Adjust Black & White Adjust which values in the image will be 
represented as black or white.

Invert Colors Make colors in the image their 
opposites.

Descreen In the scanned image, reduce the 
appearance of undesirable patterns 
that are in a printed original.

Advanced

Show Balloons
Hide Balloons

Turn on and turn off Balloon Help.
If you are using Balloon Help, Hide 
Balloons appears. If you are not using 
Balloon Help, Show Balloons appears.

HP Precisionscan Pro 3.1 
Help

+? View the Help for the HP scanning 
software.

HP Scanjet on the Web Connect to the Internet and visit the 
HP Scanjet website.

Product Tour View the product tour.

User’s Manual View the printable user’s manual in PDF 
format.

Enable All Smart Friends Allow helpful alerts to appear when 
potential problems arise.

Disable All Smart Friends Prevent helpful alerts from appearing 
when potential problems arise.

Help
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HP Precisionscan Pro tool and information 
bars

The HP Precisionscan Pro software contains a toolbar and an Info bar 
to help you use commands quickly or find information about the current 
scanned image.

Toolbar

The HP Precisionscan Pro software displays a toolbar containing 
shortcut buttons for common commands.

Click this button To

New Scan Start (preview) a new scan.

Scan To... Perform a final scan and send to a destination, 
such as e-mail.

Scan to CD Scan and save the selection to rewritable CD.

Save As... Save the selection area as a file.

Print Scan and print the selection area.

Return Image To... When using TWAIN or the HP Scanjet Plug-in, 
return the scanned image to the other program.

Copy Scan and place the selection area on the 
Clipboard.

Zoom In Zoom in on the selection area.

Zoom Out Zoom out to the original view.

Rotate Left 90 Rotate the image counterclockwise by 90 degrees.

Rotate Right 90 Rotate the image clockwise by 90 degrees.
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Info bar

The info bar appears at the bottom of the preview window and displays 
the following information:

l the width of the output image

l the height of the output image

l scale of the output image

l the output type currently selected

l one of the following:

l A progress bar that shows when the scanner is scanning or the 
scanning software is processing a command.

l The number of KB (kilobytes), MB (megabytes), GB (gigabytes), 
or TB (terabytes) in the image in the selection area. This size is 
only an estimate of the actual size of the image. The file can be 
larger or smaller than the value shown here. The size of a saved 
file depends on the format used to save the file.

l an XPA icon, if the XPA (Slides) or XPA (Negatives) commands 
are selected in the Scan menu

Undo Editing 
Changes

Return all settings except output type to the 
defaults for this image.
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Context-sensitive cursors

The shape of the pointer indicates the type of activity you can perform 
in the scanning software.

�����	���
����
������

New selection 
area

Draw a new selection area.

Move selection 
area

Drag the selection area to a new location in the 
preview area.
Drag the selection area to another program.
Press OPTION and drag the selection area to the 
desktop or a folder.

Resize selection 
area horizontally

Appears on the sides of the selection area. Drag 
the cursor to resize the width of the selection area.

Resize selection 
area vertically

Appears on the top or bottom of the selection area. 
Drag the cursor to resize the height of the selection 
area.

Resize selection 
area diagonally

Appears on the corners of the selection area. Drag 
the cursor to resize both the height and width of the 
selection area.

+����
������

Ready for activity Click a menu item and select a command.
Click a list button to select an option.
Click a button to turn it on or off, or to increase or 
decrease a number.

������
������

Data entry 
accepted

Click, then type a value.

��!��
)����
������

Highlight 
eyedropper

Position this cursor over a light area in the image to 
see its pixel value in the RGB meter and the 
histogram. Click on pixels to set them as the 
Highlight value. In the Transparency Exposure 
Adjustment tool, click to set the RGB value.

Shadow 
eyedropper

Position this cursor over a dark area of the image to 
see its pixel value in the RGB meter and the 
histogram. Click on pixels to set them as the 
Shadows value.

Eyedropper and 
the “no” symbol

Indicates this area is an area in which pixel value is 
not available.
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B Glossary

symbols

5"��	
���������

Used to represent black-and-white photos accurately. These grayscale 
images contain 256 shades of gray.

67"��	
�����

Color images composed of three 8-bit color channels. When 
combined, the red, green, and blue channels provide up to 16 million 
colors. This is also referred to as true color.

a

�� ����

A command offered by programs that support TWAIN or the HP 
Scanjet Plug-in. Selecting Acquire takes you directly to the selected 
scanning software, and then returns the scanned image to the 
requesting program.

��	�)�
������

The program you are currently using or that is currently selected. A 
program’s title bar changes color to distinguish active from inactive 
programs.

&%'


See automatic document feeder.

&�	�)�
3�&

Or XPA. See transparency adapter.

&%'

See automatic document feeder.

&%'
�����

The piece of glass on the scanner bed that the ADF uses to scan 
documents from the feeder tray.
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��������

The visibly jagged steps along angled lines or object edges that result 
from sharp tonal contrasts between pixels. Seen in both black-and-
white images and color images. Sometimes called Jaggies.

��	�"��������

A technique that smooths transitions between pixels, reducing the 
jaggedness of curved lines.

�����!��	�
����

Reflects the amount of disk space a scan would require if saved to 
your computer. Approximate Size value does not apply if the output 
type for the scan is set to text; it only applies to an image 
representation of the scan.

��	�,�	��-
��������

Automatic cropping displays only the item(s) detected on the scanner 
bed, not any of the surrounding area.

��	��	��
������	
������

Abbreviated ADF, it is an optional accessory that allows you to scan 
multiple pages.

&�	�,�	��-
������	���

A feature of the scanning software that automatically applies the 
optimal output resolution to the selection area. For example, output 
resolution is automatically set to 200 when the True Color output type 
is selected, and set to 300 for the Black & White Bitmap (raster) output 
type.

b

��	
���	�

The number of bits used to define the shade or color of each pixel in an 
image. A 1-bit image is black and white. An 8-bit grayscale image 
provides 256 shades of gray. An 8-bit color image provides 256 
indexed colors and is associated with a specific palette or color table. 
A 24-bit image provides over 16 million colors. The greater the bit 
depth, the larger the size of the saved file. See also file size.

��	��

A type of black-and-white, gray, or color image or picture made up of a 
matrix of individual pixels or dots. Often referred to as raster, raster 
bitmap, or raster image. 

�����
1
���	�
��	��

Black & white raster bitmaps contain only black pixels and white pixels, 
no colors or shades of gray. Each pixel represents one bit.

0����
1
���	�
���������
	���

The Black & White Threshold tool lets you change the dividing point for 
black-and-white pixels in an image that uses the Black & White Bitmap 
(raster) output type. All pixels below the threshold will be output as 
black, and all pixels above the threshold will be output as white.

������

A line surrounding the scanned image indicating scanning boundaries. 
Clicking the image reveals a selection border and handles that are 
used to define the scanning region.
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�����	����

The balance of light (highlights) and dark (shadows) in an image. In 
black-and-white images, the lower the brightness, the closer the image 
will be to black. The higher the brightness, the closer the image will be 
to white. Brightness should not be confused with contrast, which 
measures the range between the darkest and lightest shades in an 
image. Brightness determines the intensity of shades in an image, 
while contrast determines the number of shades in the image.

c

�����

To press and release the mouse button once.

�������
��!���

Pixels in an image that are extremely light or extremely dark and that 
would lose detail when the image is printed or displayed.

�89:

Cyan, Magenta, Yellow, Black. The color model in which all colors are 
composed of Cyan, Magenta, and Yellow, the primary colors of 
pigments like ink, plus Black. Printers use CMYK to print in color.

���)��	��
	�!	


Text that has been rendered into digital format by an OCR program.

�����
�������


The preservation of balance between colors throughout the tonal 
range. Color balance is particularly important when scanning objects 
that include neutral tones (grays) or large areas of consistent color.

�����
�������


The red, green, and blue components from which colors are created.

�����
������	���


The process of adjusting an image to compensate for input and output 
device characteristics or color flaws in the original image.

�����
���	�

The number of colors that a monitor can display at once. Most 
Macintosh monitors can display in 256 grays, 256 colors, thousands of 
colors, and millions of colors. The higher the color depth, the more 
lifelike images look on screen.

�����
�����


A tool used to adjust the color balance and hue.

���������


The ability to adjust settings that determine how the scanner buttons 
and scanning software perform operations.

���	�!	"�����	�)�
����


Context-sensitive Help answers questions related to the currently 
displayed window. The Help is provided in four ways: Text Labels, 
ToolTips, Info bar messages, and Help commands. 

���	���	


The range between the lightest and darkest shades in an image. An 
image with high contrast has few gray shades between black and white 
and appears to be dominated by stark light and dark tones. An image 
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with low contrast has many shades of gray and tends to look flat and 
dull. Change contrast using the highlight, shadow, and midtone 
settings.

���	���
�����

This range determines the number of bits used for exposure 
compensation, shadow detail, and black-and-white threshold 
adjustment displays. The higher the bit depth, the finer the level of 
control in adjusting these image manipulation functions.

����


To eliminate portions of an image from the final scan. 

d

������	
��		����

Predetermined settings in the scanning software that define levels on 
your behalf. Default settings in the HP Precisionscan Pro software are 
set for Output Type, Output Resolution, Color, Exposure, Black & 
White Threshold, and Sharpen Level. You can override default 
settings.

�����	�


The ability of a material to absorb or transmit light. The greater the 
density of a material or object, the more black it contains. This applies 
to both black-and-white images and color images.

��������

The process of removing an unwanted pattern, such as a moiré 
pattern, that appears in a printed original so the pattern does not 
appear in the scanned image.

���	���	���


The file, program, or hardware device where the scanned image will be 
used. Examples include a printer, a Web page, or an e-mail program.

��)���
���)��


Software that the system uses to communicate with devices, such as a 
display, printer, mouse, or scanner.

�������
������	���


The number of pixels that a computer monitor can display both 
horizontally and vertically. Screen resolutions are typically 640 x 480 
(VGA), 800 x 600 (super VGA), or 1024 x 786.

��	������


The process of approximating pixel colors when reducing the color 
depth of an image. Dithering can improve transitions between colors 
when reducing a 24-bit image to 8-bit format.

������	

For the purposes of this documentation, document refers to an original 
item containing text or both text and images. It also means an original 
item scanned using the automatic document feeder.

��	�
���
����


See dpi.

������"�����


To press and click a mouse button twice in rapid succession.
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���

Dots Per Inch. The number of dots in a linear inch. DPI measurements 
are used to describe the resolution of printers and scanners, where 
printed images and words are made up of a series of round dots. The 
greater the DPI number, the higher the resolution.

����

To move an object on screen. Place the cursor over the image or 
selection area, hold the mouse button down, and move the mouse to 
move the object.

����"���"����


To move an object to a new location and keep it there. Click on the 
object and drag it to a new location, such as an open document in 
another program, and release the mouse button. When dragging-and-
dropping between programs, a copy of the object is placed in the 
receiving program.

����"����
���	
,��
���-

A list of items that appears when you click on or pass the cursor over a 
command such as File or Edit.

e

���	����
	�!	


Text that is converted from a scanned image into characters you can 
modify in a word processor or other text-editing program. Depending 
on the capabilities of your program, you can change the font, size, 
style, and other attributes of editable text, as well as edit words or 
phrases.

�"���


A network over which you can transfer messages and electronic files. 
E-mail is also sent via Internet browsers. 

�!���	

To save a file in a particular file format for use in other programs.

�!������


The amount of light, or brightness and contrast, in an image. 

f

����
����	

The format in which a scan is saved. Certain file formats enable 
programs such as word processors to insert, open, or import scans. 
Common graphics formats include JPG, GIF, and TIFF. Common text 
formats include plain text and RTF (Rich Text Format). 

����
����


The number of bytes in a file. The file size of scanned images is 
determined by resolution, file type, output type, and scaling. To reduce 
the file size of photographs, for example, you could decrease bit depth 
or resolution. 

�����
����


The actual image, defined by the selection area, that is sent to a 
destination such as a file, a printer, the Clipboard, or another program. 

�����
����


The approximate height and width of the final image to be scanned. 
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������
	�!	

The Flowed Text option converts output into one column, placing 
images as closely as possible to the appropriate text.

�����
	�!	

The Framed Text option places text and images in a frame, positioned 
as closely as possible to the way they appear in the original document. 
Text may be more difficult to edit extensively since the frames may not 
expand to hold additional text.

�����


Refers to the sharpness of an image.

����	
�����

The area on the front of the scanner hardware containing the buttons 
for sending an item to a destination or changing settings.

g

���


The contrast that affects the mid-level grays or midtones of an image. 
Adjusting the gamma of an image allows you to change the brightness 
values of the middle range of gray tones without dramatically altering 
the shadows and highlights. This applies to both black-and-white 
images and color images. The default setting of 2.2 ensures integrity 
among computer systems.

������


Refers to images, pictures, or photographs in which individual pixels 
are relatively large and have areas of white between them, thus 
reducing the overall perceived quality of the image. Graininess can 
occur when you scan a poor-quality original or reduce the bit depth of 
the scanned image by dithering or halftoning.

/�������
��	��������
'���	
,/�'-

A graphic file format that is supported by many programs. Files saved 
in this format support 256 colors. 

���������


An original or output type containing shades of gray, not just black and 
white. In a grayscale image, each pixel contains multiple bits of 
information, allowing more shades of gray to be recorded and 
displayed. Four bits can reproduce up to 16 levels of gray, and eight 
bits can reproduce 256 shades of gray. Grayscale is commonly used 
for black-and-white original photographs but is also effective in 
maintaining shading in pencil drawings. 

h

����	���


An original composed of a pattern of dots that tricks the eye into seeing 
shades of gray or color. Halftones are common in all printed materials. 
Scanning halftones instead of photographic originals can result in 
lower final image quality.

�����	

The vertical dimension of a scan as it will appear at its destination.
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��������	�


The lightest portion of an image, usually reproduced as white on the 
computer screen or when printed. 

���	����


A graphical representation of the concentration of pixels at each 
intensity or gray level in the selection area of the scanned image. 
Histograms help determine the optimal highlight, shadow, or threshold 
value of an image. 

��
����.�	
����
#	���	�


A software utility used to select number of copies, destination printer, 
and other copy options.

��
�������������
���
���	����

The scanning software that HP provides for previewing an image 
before sending it to a destination; making changes, such as resolution, 
resizing, and contrast; and saving images as files.

��
����.�	
����"��

A Photoshop plug-in for image editor and OCR programs, which allows 
you to scan text and images from within these programs. 

��
�����"	�"���


An automated feature that sends scanned images directly to a 
destination on the Web.

��8*


HyperText Markup Language. A language used in creating documents 
for the World Wide Web. Documents can be saved in HTML.

���


The distinctive characteristic of a visible color that enables you to 
distinguish it from other colors. Six hues are especially important in 
photography, scanning, and printing: red, yellow, green, cyan, blue, 
and magenta. Hue is determined by the frequency of the wave of light 
that creates the color. See also saturation.

i

����


An electronic picture that can be displayed on a computer screen or 
saved to a disk. 

����
���	��

A program that lets you modify bitmapped drawings and photographs.

����
����


The size of the image expressed in bytes and displayed in the Info bar. 
File size and image size may vary, depending on the file type.

����	

To bring a scanned image into a document from another program.

����
���


A form of assistance that appears in the lower, left corner of the screen 
and displays the width and height of the output image, the scale 
percentage, the output type currently selected, and the size of the 
output image.
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��	������
������	���

The connection between the scanner and the computer. This can be 
either a USB, parallel, or SCSI connection depending on the model of 
scanner and your operating system.

��	������	��
������	���


Resolution that is changed in the scanning software rather than in the 
hardware. For example, if your scanned image is 600 dpi, you might be 
able to enhance it to 1200 dpi in the scanning software. This is useful 
for enlarging small images.

��	������	���


The process of increasing the resolution of an image by the addition of 
new pixels throughout the image, the colors of which are based on 
neighboring pixels.

��)��	


To reverse the colors in an image (for example, in a black-and-white 
image, black areas are turned white and white areas are turned black). 

�	�

The physical drawing, photo, collage, etc. you place in the scanner to 
scan. Once it is scanned, it is referred to as an image or scanned 
image.

j

.�����


Refers to the uneven transition between black and white, or areas of 
color, in a scanned image. Jagged edges can be avoided by scanning 
at a higher resolution than your output device, or by not scaling the 
image after scanning it.

;�4/


Joint Photographic Experts Group. A compressed file format that 
reduces file size and enables faster file access. This format can reduce 
image quality and performance when the file is decompressed and 
recompressed. 

k

��������
����	��	�


A keystroke or combination of keystrokes that allows you to quickly 
accomplish common tasks.

l

���������


The orientation of a photograph or image that is wider than it is tall. 
When an image is taller than it is wide, it is called portrait orientation.

m

�!��
��!��
���	�

This option enables higher bits per pixel when the scan is sent to the 
software. When it is off, 8 bits per pixel are returned for grayscale and 
24 bits for color. When it is turned on, 16 bits per pixel are returned for 
grayscale and 48 bits for color. 
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��	����


The gray shades of an image. Midtones are usually between 30% and 
70% black. Midtone control adjusts the brightness of gray levels in the 
image so that the lightest and darkest portions of the image can be 
properly displayed on your monitor. The higher the setting, the brighter 
the image appears on your monitor.

�������
��
������

Color images that are composed of three 8-bit color channels. When 
combined, the red, green, and blue channels provide up to 16 million 
colors. Sometimes referred to as “true color” and “24-bit color.”

���<


An undesirable pattern in color printing that results from incorrect 
screen angles of overprinting halftones. Moiré patterns usually result 
when you scan a halftone, when you scan images taken directly from a 
magazine, or when you scale an image in an image editor after it is 
scanned.

n

����	�)�
������

This XPA piece holds negative strips for scanning. Insert it into the 
slide holder on the bottom of the XPA light source for proper scanning 
of negatives.

����	�)�
����	
������

This XPA piece blocks excess illumination and improves image quality 
when scanning negatives. Slide it into the negative holder after the 
chosen negative strip.

�����
�����	���

This option reduces the noise (unwanted specks) in an image by 
applying software algorithms to minimize the effects of noise in the 
scanner electronics.

o

(�+


See optical character recognition.

��	����
������	��
�������	���

Abbreviated OCR. A technology that recognizes letters in a scanned 
image and converts them into ASCII characters, or editable text.

��	����
������	���


The true resolution of a scanner, the resolution at which the scanner 
captures images. See also interpolated resolution, resolution. 

��	�����
����		�


A palette or color table that contains the pixel colors present in an 
image.

��������


The original document or picture to be scanned. 

��	��	


The file that is generated by the scanning process.
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��	��	
���������


The actual height and width of an image when saved. You will not see 
the size changes to your image in the Preview area since image size 
affects only the final scan.

��	��	
	���


The type of file that is generated during the scanning process. Output 
type reveals the bit depth of the image.

p

����		�


A subset of the color look-up table that establishes the colors that can 
be displayed on the monitor at a particular time. The only color depth 
that allows multiple palettes is the 256 (or 8-bit) color setting for your 
monitor. At a color depth of 256 colors, each program (or even each 
individual image used or edited in a program) can have a different 
color palette.

����		�
��������


The flashing that occurs when your monitor is set to a color depth of 
256 colors and you switch programs. When you switch programs, the 
palette of the active program becomes the system palette, and all other 
programs redraw themselves as accurately as possible with the new 
colors.

�%'

Portable Document Format (PDF) format. Adobe Acrobat files use this 
format.

����

Apple's proprietary image file format that is used by the Mac OS. 
Designed for the screen, this format is best used for color images that 
will not be printed. Images saved as PICT files are smaller in size than 
images saved as a TIFF files.

��!��


The smallest element (picture element) that can be assigned an 
independent color and intensity and can be displayed on a computer 
screen. Pixels are square dots arranged in a grid pattern to make up 
the images displayed on the screen.

����"��

A module that integrates into a program to provide additional 
functionality. The HP Precisionscan Pro Installer adds a Photoshop 
plug-in (the HP Scanjet Plug-in) for image editor and OCR programs 
that allows you to scan text and images from within these programs. 

�$/

Portable Network Graphics format. A compressed image file format 
suitable for the Web that might replace GIF because of copyright 
issues with GIF format. PNG is non-lossy compressed, supports 
interlacing, and can be used with the True Color output type, which 
GIF cannot.

���"��
���
,��
���	-

A menu of items that appears when you click on or pass the cursor 
over a command.

���	���	


Orientation of a photograph or image that is taller than it is wide. An 
image that is wider than it is tall is called a landscape orientation.
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����	������
���	�

This XPA piece is a large template with a rectangular cutout that 
orients proper placement of the XPA light source on the scanner bed.

���	���
�����

Term for scanning items directly to a website.

�����
��)�

An energy conservation method that reduces power consumption 
when the scanner is idle for a period of time.

���


Pixels Per Inch. A measurement of resolution for monitors and 
scanners where the individual element is a square pixel.

�����������

Refers to your preferred method of using the scanner. The scanning 
software automatically saves certain preferences, such as the location 
of toolbars and the destination of a scan, that it detects during normal 
use of the scanner. Some preferences are restored each time the 
scanner is used, while others are maintained only throughout a 
scanning session.

���)���


A feature that displays a scanned image so you can view it in the 
scanning software. You can then select an area to be saved; make 
adjustments to the tone, color, and size; and save the final image.

���)���
������

The rectangular area in the software where the scanned image is 
displayed.

����	��
������	���


A measurement of the number of dots per inch (dpi) the printer is 
capable of printing. Typical laser printers have resolutions of 600 dpi, 
typical ink printers have resolutions of 300 dpi for photographs and 600 
dpi for text, while imagesetters have resolutions of 1200 or 2400 dpi. 
The more dots per inch, the smoother the output and the greater the 
number of grayscale levels and colors the device can describe.

������	
	���

The product tour provides an overview of the scanner’s capabilities 
and how scanning tasks are completed. It appears each time the 
scanning software starts, unless it is specifically disabled. It is also 
available in the Help menu.

q

r

���	��


A type of black and white, gray, or color image or picture made up of a 
matrix of individual pixels or dots. This is also referred to as a bitmap.

������	���


The measure of how many dots per inch (dpi) are scanned, displayed, 
or printed. The greater the dpi, the greater the amount of detail that is 
visible, and the larger the file size. The final output device (monitor, 
printer) for a scanned image determines the resolution of the image. 
For example, if you scan a picture at 600 dpi (the optimum) and your 
printer is capable of printing at only 300 dpi, the printed image will be 
no more than 300 dpi.
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+/0


Red, Green, Blue. The color model in which every color is composed 
of a varying amount of red, green, and blue, which are the three 
primary colors of light. RGB is used to display colors on a computer 
monitor. 

����
	�!	
����	


A format for text files. Rich Text Format preserves all formatting in the 
original text document. It converts formatting into instructions that 
compatible programs can interpret. 

��	�	�
	���


To rotate the entire scan 90 degrees clockwise or 90 degrees 
counterclockwise.

s

��	���	���


The intensity of color in a specific hue. An image with high color 
saturation has vivid color. A black-and-white photograph has zero 
saturation. See also hue.

�����


To reduce or increase the physical size of an image while maintaining 
aspect ratio (the ratio of the horizontal dimension to the vertical 
dimension).

����


To capture a picture, photograph, or text as a digital electronic image 
using a scanner. This term also refers to the image that has been 
scanned.

�������
���


The glass surface of the scanner where you place items to scan. 
Sometimes referred to as the scanner glass.

�������
�����


The glass surface on the scanner where you place items to scan. 
Sometimes referred to as the scanner bed.

�������
���

The lid, or cover, of the scanner, which holds the original paper flat for 
scanning.

��������
������


Scanning (or scan) sources include the flatbed, transparency-slides, 
and transparency-negatives.

������
������	���


The measurement of the number of lines per inch (lpi) that a screen 
can display. This is usually 72 lpi.

��		����

Saving settings allows you to save a set of settings used with one 
scanned image and reuse the settings with an image scanned in the 
future. 

�����	���
����


The area inside the rectangular border drawn around a portion of the 
image in the Preview area. The selection area is scanned when you 
drag-and-drop, save to a file, copy to the clipboard, or print.
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������


The darkest area of an image, usually reproduced as near black on the 
computer screen or when printed. The range between highlight and 
shadow determines the quality and color differentiation in the image. 

�������


To enhance the detail in an image. 

�����
������

This XPA piece holds slides for scanning. It is attached to the bottom of 
the XPA light source.

�����
����	
������

This XPA piece blocks excess illumination and improves image quality 
when scanning slides. Slide it into the slide holder after the chosen 
slide(s).

���	
'������

Smart Friends are tips that appear automatically to notify you of 
potential problems. For example, if you are setting a very high 
resolution but want to use e-mail to send the scanned image, a Smart 
Friend would alert you that the file will probably be too large to send in 
e-mail.

������


The program from which an image is retrieved for use in a document. 
Programs that support TWAIN or the HP Scanjet Plug-in pull an image 
from a source, such as the HP Precisionscan Pro software.

�����
%��	���	����

The list of destinations available when configuring the Scan To button 
options in the HP Scanjet Controls control panel. This list of 
destinations appears in place of the standard Scan To button options 
and allows the settings for each available destination to be set from 
one dialog box, rather than by selecting each destination separately 
from a pull-down menu. Speed Destinations are available with some 
scanner models.

���	
�����


A software function that finds large areas of color in a scanned image 
and applies a uniform color to the area.

�+/0

An international color standard and the default color system used for 
all HP peripherals, the World Wide Web, and most office software.

���	�
����		�


A palette or color table containing a Web palette plus more shades of 
gray and the 16 VGA colors. 

t

	�!	

As it relates to scanning, text is saved in the following formats: plain 
text, HTML, and RTF.

	�����������


The process of rendering all areas darker than a set value as black, 
and all areas lighter than a set value as white. Useful when converting 
grayscale images to black and white. 
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��''


Tagged Image File Format. A bitmapped file format for images, 
capable of storing up to 24-bit depth images. TIFF file format is 
especially appropriate for scanned images and is supported by many 
programs and computers. 

��''
���������

Tagged Image File Format, compressed. A bitmapped file format for 
images, capable of storing up to 24-bit depth images. TIFF file format 
is recommended for scanned images and is supported by many 
programs and computers. TIFF compressed files use data 
compression to reduce the size of the resulting file. 

	���


The overall effect produced by the combination of lighting, shade, and 
color.

	������


The area that contains buttons for a program's controls.

	�����������
����	��

Abbreviated as XPA. An optional accessory used to scan negatives 
and slides. An XPA connector is plugged into the scanner, and a 
template is used to position the transparency above the glass.

����
�����


An image type that is rendered with 24-bits per pixel per color.

��&�$


An industry-standard communications protocol for sending instructions 
to hardware (such as a scanner) and receiving image data back from 
them. If you are using a program that supports TWAIN, you can start 
the HP Precisionscan Pro software directly from that program.

u

������
�������


A method of stretching or shrinking an image proportionately in both 
the vertical and horizontal directions. 

#�0


Universal Serial Bus. An interface for connecting peripherals, such as 
scanners, to a computer.

v

)��	��


A type of image that uses algebraic equations to define the various 
lines and curves of the image. 

w

���
����		�


A palette or color table containing red, green, and blue pixel colors that 
is standard for images embedded in Web pages or HTML files. It 
consists of 216 entries of all combinations of the values 0, 51, 102,153, 
204, and 255.
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���	�

The horizontal dimension of your scan as it is sent to its destination.

x

3�&

See transparency adapter.

3�&
����	
������

This XPA piece is a light that plugs into the scanner. It fits into the 
positioning plate and provides backlighting in order to properly scan 
transparent slide and negative images. (It may also be used as a light 
box for viewing slides.)

y

z

���
����


The ability to enlarge, or magnify, the image in the Preview area so that 
finer adjustments can be made to the image. This action does not 
enlarge the picture that is saved, printed, copied to the Clipboard, or 
dragged into another program.
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Index

A
About HP Precisionscan Pro command 116
abrasive cleaners, avoiding 112
accessories, using 77
accuracy, OCR 76
acquiring scans 74
active program, definition 123
ADF (automatic document feeder)

capacity 105
cleaning 112
document specifications 17
feeding problems 105
glass, definition 123
jams, clearing 108, 110
jams, preventing 105
loading 78
models including 3
page size options 38
Scan dialog box 78
scanning from 78
troubleshooting 105

Adjust Black & White command
shortcuts 118
using 57

Adjust Color command
shortcuts 118
using 56

Adjust Exposure command
highlights 51
midtones 50
shadows 52
shortcuts for 118
transparent items, using for 83

adjusting
backgrounds 54
black and white threshold 57
brightness 50
color channels 58
contrast 46
highlights 51
hue 56
midtones 50
output levels 54
preferences for scanner buttons 35
preferences for scanning software 70

saturation 56
shadows 52
tonal resolution 73

Adobe Acrobat Reader 62
Advanced menu, shortcuts for 118
alarms, highlight and shadow 53
albums, photo 30
alcohol, cleaning with 111, 112
alerts

highlight 53
shadow 53
Smart Friends 40

aliasing, definition 124
anti-aliasing, definition 124
Apple Menu

About HP Precisionscan Pro command 116
Control Panels 35

approximate size
definition 124
viewing 120

areas, selecting. See selection areas
ASCII text, saving as 62
attachments, e-mail

creating 31
naming 32
Prompt for e-mail attachment name option 37

automatic cropping
definition 124
settings 38

automatic exposure adjustment 72
automatic resolution 124
Automatically Set Type option 43

B
backgrounds, adjusting 54
balance, color

adjusting 56
definition 125

Balloon Help 118
bed, scanner

definition 134
printing entire 63
selecting entire 42

best quality settings 71
bit depth, definition 124

bitmap files, definition 124
black and white bitmaps

adjusting colors in 58
definition 124
shortcut for 117

black and white copies
button for 27
making 22, 33

black and white images
inverting colors 49
output types for 44

Black and White output type, selecting 38
black and white threshold

changing 57
definition 124

black areas, adjusting 52
black eyedropper tool 52
black images, troubleshooting 94
black output levels, changing 54
blank pages, troubleshooting 33, 94, 96
blue color channel 58
blurred scans, troubleshooting 94
books, scanning pages from 17
borders, selection

definition 124
moving 42

boxes
around slides or negatives 98
around text 75

brightness
adjusting 50
definition 125

bulbs, broken 98, 104
business cards, scanning 17
Buttons tab, HP Scanjet Controls

accessing 35
ADF Page Size options 38
Destinations options 37
Image options 38
Scan To settings 36

C
Cancel button 27
canceling scans 33
capacity, ADF 105

carbon paper, scanning 17
CDs, scanning to 67
Change Resolution 117
characters, incorrect 99
checklist, troubleshooting 88
cleaning

ADF 112
scanner 111
XPA 112

clearing ADF jams 108, 110
click, definition 125
clipped pixels

checking for 53
definition 125

CMYK, definition 125
collating copies 33
color balance

adjusting 56
definition 125

color channels
changing 58
definition 125

color copies
button for 27
making 33

color correction
automatic 72
definition 125
highlights, adjusting 51
hue, adjusting 56
midtones, adjusting 50
saturation, adjusting 56
shadows, adjusting 52

color depth
definition 125
output types 44

color output types 44
color wheel

adjusting hue 56
definition 125

colored paper
adjustments for 58
copying from 96

colors
automatic adjustment 72
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converting to black and white 58
highlights, adjusting 51
hue, adjusting 56
inverting 49
midtones, adjusting 50
negatives, troubleshooting 98
output types 43
RGB values, viewing 55
saturation, adjusting 56
shadows, adjusting 52
slides, troubleshooting 98
tonal resolution 73
troubleshooting 94, 97

comparison, features 3
compressed file formats 62
contrast

adjusting 46
definition 125

Control Panels, HP Scanjet Controls 35
control range, definition 126
Controls tab options 73
copies, making

quality, troubleshooting 96
troubleshooting 101
using HP Scanjet Copy Utility 16
using scanner button 33

Copy button
locating 27
troubleshooting 106
using 33

Copy command
shortcuts 117, 119
using 65

Copy Utility, HP 16
copying and pasting

toolbar shortcut 119
using Clipboard 65

correction, color
automatic 72
definition 125
highlights, adjusting 51
hue, adjusting 56
midtones, adjusting 50
saturation, adjusting 56
shadows, adjusting 52

crooked images, troubleshooting 94
crooked pages, troubleshooting 105
cropping

automatic, settings for 38
definition 126
scanning area 42

Current OCR Language option 73
cursors

black eyedropper 52
context-sensitive 121
dragging-and-dropping 66
Ready 121
Selection Area 121
Typing 121
white eyedropper tool 51

customer support
resources for 113

customizing
preferences for scanning software 70
resolution values 72
scanner buttons 35

cut off pages, troubleshooting 96

D
dark areas

adjusting 52
troubleshooting 93

darkening images 50
dashed boxes 98
decreasing

details for transparent items 84
details in dark areas 52
details in light areas 51
saturation 56

default programs, changing 35, 99
default settings

definition 126
resetting image adjustments 48
Restore Defaults (scanner buttons) 35
Scan To button 36

deleting selection areas 42
density, definition 126
depth, color

definition 125
output types 44

Descreen command
settings 71
shortcuts 118
using 59

desktop, dragging-and-dropping to 66
destinations

definition 28
options 37
Scan To button, changing 36
scanning to 29
select button 26
Speed 8, 36
troubleshooting 101

details
black and white threshold 57
clipped, checking for 53
decreasing in dark areas 52
decreasing in light areas 51
enhancing 52
increasing in dark areas 52
increasing in light areas 51

device driver, definition 126
dimensions

paper sizes 17
resizing images 45

Disable All Smart Friends 40, 118
display resolution

definition 126
image quality 23
output types for 44

distribution, pixel 55
dithering, definition 126
documentation, printing 15
documents, definition 126
dots per inch (dpi), definition 127
dots, troubleshooting 93
double-click, definition 126
dpi (dots per inch), definition 127
dragging-and-dropping

between programs 66
definition 127
to desktop 66

drawings, output types for 44
drop-down list, definition 127

E
edges not printing 96
Edit Destination 36
Edit menu, shortcuts for 117
editable text

accuracy of 76
creating using OCR 75
definition 127
languages 73

options for 73
Scan To Text File 23
troubleshooting 99

8-bit grayscale, definition 123
E-mail button

locating 26
troubleshooting 101
using 32

e-mail, definition 127
e-mailing scans

attaching files 31
file sizes 46
supported programs 31
troubleshooting 101
using scanner buttons 32

Enable All Smart Friends 40, 118
Enable Scan Another Page Dialog 71
Energy Save mode 107
enhancing details 48, 52
error messages 90
export, definition 127
exposure

adjusting 50
automatic adjustments 72
definition 127

eyedropper tools
black 52
functions of 121
viewing RGB values 55
white 51

F
fabric, scanning 17
FAQs (frequently asked questions) 22
Faster Scan mode 107
features, scanner models 3
feeding problems, ADF 105
file formats

e-mail attachments 32
supported 91
types of 62
websites 64

File name, e-mail attachments 32
File Open 91
file sizes

definition 127
reducing 23
resolution changes 46
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status bar 120
files

attaching to e-mail 31
dragging and dropping 66
lost 90
saving to 61

film, scanning
adjusting colors 83
negatives 81
slides 79
troubleshooting 98

final scans
definition 127
selecting areas for 42

fingerprints, cleaning 111, 112
flashing palette, definition 132
flipping images 47
flowed text

definition 128
preferences 73

focus, definition 128
folders, dragging-and-dropping to 66
font sizes, OCR 76
Force Quit 88
Format, e-mail option 32
formatting, text 100
framed text

definition 128
preferences 73
removing frames 75

frequently asked questions 22
front panel, definition 128
frozen programs 88
fuzzy images

sharpening 48
troubleshooting 95, 97

G
gamma

changing setting 71
definition 128

GIF files
definition 128
output types for 44
using 62

glass cleaner, using 111, 112
glass, ADF

cleaning 112

definition 123
glass, scanner

cleaning 111
definition 134
loading items 19
preparing documents for 17

grainy, definition 128
graphics

cut off 96
file formats 62
OCR conversions 75

grayscale
8-bit 123
definition 128
option, selecting 38
output type, using 44
shortcut for 117

green color channel 58
grinding sounds, troubleshooting 91
gum-backed paper, scanning 17

H
halftone, definition 128
handwriting, converting 76
Height field, resizing images 45
Help, Balloon 118
Help, online

HP Scanjet Copy Utility 16
printing 15
shortcuts for 116, 118
using 40

highlights
adjusting 51
alarms 53
automatic adjustment 72
clipped areas, checking for 53
definition 129
histogram 55
transparent items, adjusting for 84

histograms 55, 129
HP Precisionscan Pro Help 40
HP Precisionscan Pro software

customizing settings 69
dragging-and-dropping files using 66
features 39
help, using 40
menus, troubleshooting 92
preferences, setting 70

product tour, viewing 15
Scan To button, using 28
scanning with 41
settings, automatic 22
Share-to-Web 64
shortcuts 116
starting 40
toolbar shortcuts 119
tools 45
uninstalling 113
when to use 16

HP Scanjet Copy Utility 16
HP Scanjet on the Web 118
HP Scanjet Plug-in

definition 129
returning scans with 61
troubleshooting 103
using 74

HP Share-to-Web 64
HP Share-to-Web wizard 30
HTML file formats

definition 129
using 62

hue
adjusting 56
automatic adjustment 72
definition 129
keyboard shortcuts 118

I
Image and Text option 37
Image file, e-mail setting 31
Image option 37
Image Output options 38, 73
image quality, troubleshooting 93
images

darkening 50
definition 129
file formats 62
highlights, adjusting 51
inverting colors 49
lightening 50
midtones, adjusting 50
mirroring 47
output levels, adjusting 54
resizing 45
rotating 47
sending to programs 60

shadows, adjusting 52
sharpening 48

Import command 91
import, definition 129
importing scans 74
increasing

details 52
image clarity 48
saturation 56

info bar 120, 129
input tray, ADF

loading 78
troubleshooting 105

insufficient memory, troubleshooting 96
interface connection

definition 130
internal mirror, contaminated 96
interpolated resolution, definition 130
Invert Colors command

shortcuts 118
using 49

isopropyl alcohol, cleaning with 111, 112

J
jagged images

definition 130
troubleshooting 97

jaggies, definition 124
jams, ADF

clearing 108, 110
preventing 105

JPEG files
definition 130
output types for 44
using 62

K
keyboard shortcuts 116

L
lamp

automatic turn-off 91
broken 98, 104
modes 107
stays on 90

landscape orientation, definition 130
languages, OCR 73
launching software 40
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lid, scanner 134
light areas

adjusting 51
copies, troubleshooting 96
scans, troubleshooting 93

light bulbs
broken 98, 104
stay on 90

light media, scanning 17
light shield

negatives 81
slides 80

light source, XPA 80, 137
lightening images 50
lines, troubleshooting 93, 96
loading items

ADF 78
scanner glass 19

loading settings 69
lock, scanner 90
long items, scanning 106

M
magazine pages, scanning 17
making copies

black and white 22
quality, troubleshooting 96
troubleshooting 101
using HP Scanjet Copy Utility 16
using scanner button 33

manual, printing 15
margins, adjusting for 96
Maximum Pixel Depth

definition 130
option 71

memory, insufficient 96
menu shortcuts 116
menus, troubleshooting 92
messages, error 90
Microsoft Word, removing frames in 75
midtones

adjusting 50
automatic adjustment 72
definition 131
range for 50
transparent items, adjusting for 83

millions of colors 131
Mirror command

shortcuts 117
using 47

mirror, contaminated 96
mirroring images

keyboard shortcuts for 117
using tools 47

misfeeds, ADF 105
models, features 3
moiré, definition 131
More Options button

locating 27
using 35

moving selection areas 42
multipart forms, scanning 17
multiple feeds, troubleshooting 105
multiple pages

options for 37, 71
scanning 28

N
naming e-mail attachments 32, 37
negative holder

definition 131
using 81

negative light shield
definition 131
using 81

negatives
adjusting colors 83
scanning 81
troubleshooting 98

new documents, troubleshooting 102
New Scan command

shortcuts 116, 119
using 41

news clippings, scanning 17
noise reduction

definition 131
settings for 71

noisy scans, troubleshooting 91
not responding, troubleshooting 91
NTSC Gray channel 58
Number of copies button

locating 27
using 33

O
OCR

accuracy of 76
definition 131
languages for 73
options for 73
preparing text for 76
saving scans for future processing 61
Scan To Text File 23
scanning to 75
troubleshooting 99

onionskin paper 17
online Help

HP Scanjet Copy Utility 16
printing 15
shortcuts for 116, 118
using 40

online viewing, optimizing scans for 64
opening software 40
optical resolution, definition 131
Optimized Palette

definition 131
output types 44
shortcut for 117

options
ADF Page Size 38
Controls tab 73
destinations 37
Image Output 38
preferences, setting 70
Resolution 72
Scan To button 36
Scanner tab 71
Selection Area tab 72
text 73

original items
loading in ADF 78
loading on scanner glass 19
preparing 17

output dimensions
changing 45
definition 132

output levels, changing 54
output types

automatic selection 72
definition 132
menu shortcuts 117
optimal resolutions for 46
options 38
selecting 43

websites, optimizing for 64

P
Page Size options, ADF 38
pages, multiple

options for 37, 71
scanning 28

palette flashing, definition 132
palettes

definition 132
optimized 131
output types 44
system 135
web 136

paper
loading in ADF 78
sizes, ADF 17
sizes, scanner glass 17
types of 17

paper jams, ADF
clearing 108, 110
preventing 105

Paste command 65
pasting images 65
patterns, descreening 59
PDF files

printing documentation 15
uses for 62

percentages, scaling 45
photo albums, creating 30
Photo Reprint button

locating 26
using 30

photos
inverting colors 49
output types for 44
printing multiple 30
troubleshooting 95

PICT files 62
picture clippings, Scrapbook 66
pink images, troubleshooting 98
pixel color

transparent items 85
viewing 55

pixel depth, options for 71
pixel, definition 132
pixels per inch (PPI), definition 133
plug-in, definition 132
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PNG files 62
pop-up menus, definition 132
portable network graphics 62
portrait orientation, definition 132
positioning plate, XPA

definition 133
slides 79

posting scans, definition 133
Power Save button

locating 27
using 34

power, troubleshooting 88
PPI (pixels per inch), definition 133
preferences

definition 133
for scanner buttons 35
for scanning software 70
shortcuts for 116

preparing originals 17
preview window, definition 133
previewing scans

options for 71
toolbar shortcut 119
using HP Precisionscan Pro software 41

Print command
shortcuts 116, 119
using 63

printing
copies 33
documentation 15
from HP Scanjet Copy Utility 16
resolutions for 133
scans 63
toolbar shortcuts for 119
troubleshooting 101

Product Tour command 118
product tour, viewing 15
programs

e-mail 31
resizing images in 45
scanning from 74
scanning to 29
sending to 60
troubleshooting 91
word processing 100

progress bar 120
progressive JPEG files 62
Prompt for Another Page option 37

Prompt for e-mail attachment name 37

Q
quality, troubleshooting

copies 96
scanned images 93

Quit, shortcut for 116

R
raster, definition 133
Reader, Adobe Acrobat 62
readouts, tonal resolution 73
Ready cursor 121
receipts, scanning 17
red color channel 58
red line, histogram 55
reflecting images 47
removing

frames 75
selection areas 42

reprints, photo 30
Reset Tools 117
resetting

all adjustments 48
default colors 58
exposure adjustments 50
output types 44
resolution 46
sharpen levels 48

Resize command
shortcuts 117
using 45

resizing
images 45
keyboard shortcuts for 117
selection areas 42
troubleshooting 23

resolution
automatic 23
button settings 38
changing 46
definition 133
interpolated 130
optical, definition 131
print vs. screen 23
printers 133
range of values 72
screen, definition 134

troubleshooting 95
websites, optimizing for 64

Resolution tab options 72
restoring defaults

Reset Tools command 117
scanner buttons 35

Return Image To command
shortcuts 119
using 74

reversing images
color 49
layout 47

rewritable CDs, scanning to 67
RGB values

definition 134
transparent items 85
viewing 55

rich text format (RTF)
definition 134
using 62

Rotate Left command
shortcuts 117, 119
using 47

Rotate Right command
shortcuts 117, 119
using 47

rotating images
keyboard shortcuts for 117
toolbar shortcut 119
using HP Precisionscan Pro software 47

RTF (rich text format)
definition 134
using 62

S
saturation

adjusting 56
automatic adjustment 72
definition 134
keyboard shortcuts 118

Save As command
shortcuts 116, 119
using 61

saving custom settings 69
saving to files

toolbar shortcuts 119
using HP Precisionscan Pro software 61

Scale field 45

scale, definition 134
scaling images 45
Scan menu, shortcuts for 116
Scan To button

locating 26
settings for 36
Text File option 23
troubleshooting 91, 102
using 28, 29

Scan to CD 67
Scan To command

shortcuts 116, 119
Text File option 23
using 60

Scan using channel 58
Scanjet Copy Utility 16
Scanjet on the Web 118
Scanjet Plug-in

definition 129
returning scans with 61
troubleshooting 103
using 74

scanner bed
definition 134
printing entire 63
selecting entire 42

scanner buttons
color copy/b&w copy 33
Copy 33
E-mail 32
identifying 26
models including 3
number of copies 33
settings 35
troubleshooting 91
when to use 16, 25
XPA, using with 104

scanner glass
cleaning 111
definition 134
loading items 19
preparing documents for 17

Scanner Glass command 116
scanner lid, definition 134
Scanner tab options 71
scanning

destinations, definition 28
loading items 19
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methods for 16
negatives 81
preparing originals 17
previewing 41
selecting areas for 42
sending to programs 60
slides 79
using ADF 78
using HP Precisionscan Pro software 41
using scanner buttons 25

scanning source, definition 134
Scrapbook picture clippings 66
scratched templates 98
screen resolution

definition 134
image quality 23
output types for 44

Select All 42, 117
Select Destination button 26, 103
selecting

output types 43
scanning area 42

Selection Area tab options 72
selection areas

automatic 72
creating 42
cursors 121
definition 134
moving 42
removing border 42
resizing 42
zooming to 43

self-test errors 90
sending to programs

directions for 60
troubleshooting 102

settings
ADF Page Size 38
automatic 22
Controls tab 73
custom, saving 69
destinations 37
Energy Save mode 107
Faster Scan mode 107
Image Output 38
lamp 107
loading 69
resetting adjustments 48

Resolution tab 72
saving 69
Scan To button 36
scanner buttons 35
Scanner tab 71
scanning software 70
Selection Area tab 72
shortcut for 116
Text tab 73

Setup and Support guide 113
shadows

adjusting 52
alarms 53
automatic adjustment 72
clipped areas, checking for 53
definition 135
histogram 55
transparent items, adjusting for 84

Share-to-Web button
locating 26
using 30

Share-to-Web software option 64
Sharpen command

shortcuts 117
using 48

sharpening
definition 135
images 48
keyboard shortcuts for 117
options for 71

shield, light
negatives 81
slides 80

shortcuts
keyboard 116
menu 116
toolbar 119

size
ADF page size options 38
image, troubleshooting 94, 95
paper, ADF 17
resizing images 45
transparent media 18

skewed images, troubleshooting 94
skewed pages, troubleshooting 105
slide holder

definition 135
using 79

slide light shield
definition 135
using 80

slides
adjusting colors 83
scanning 79
troubleshooting 98
viewing 80

slow scanning, troubleshooting 22, 91
Smart Friends tips 40
software

uninstalling 113
source, definition 135
specifications

ADF 17
speed

troubleshooting 22, 91
Speed Destinations

models including 8
using 36

spot color
definition 135
shortcut for 117
using output type 44

sRGB
definition 135
setting profile 71

starting scans
methods for 16
using HP Precisionscan Pro software 41
using scanner buttons 25
using TWAIN 74

stopping scans 33
streaks, troubleshooting 93
stripes, troubleshooting 96
support, customer

resources for 113
supported e-mail programs 31
System Palette

definition 135
shortcut for 117

T
tab options

Control 73
Resolution 72
Scan To button 36
Scanner 71

Selection Area 72
Text 73

templates
negative 81
slides 79
troubleshooting 98

Text Files, saving as 75
Text option 37
Text tab options 73
text, editable

accuracy of 76
creating using OCR 75
languages 73
options for 73
Scan To Text File 23
troubleshooting 99

textured paper, scanning 17
threshold, black and white 57
thresholding, definition 135
TIFF files

definition 136
using 62

tips, Smart Friends 40
tonal resolution, adjusting 73
tone, definition 136
toolbar shortcuts 119
tools

black eyedropper 52
settings for 45
viewing functions of 40
white eyedropper 51

Tools menu, shortcuts for 117
transparency adapter (XPA)

cleaning 112
light source 80, 137
media sizes 18
models including 3
negatives, scanning 81
scanner buttons, using with 104
slides, scanning 79
troubleshooting 98, 104
using 79

troubleshooting
ADF 105
checklist 88
copies 96
e-mailing 101
frequently asked questions 22
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image quality 93
negatives 98
OCR 99
scanner buttons 91
scanner not responding 91
slides 98
slow scanning 22, 91
transparencies 98
TWAIN programs 103
XPA 104
zooming 23

True Color
definition 136
option, selecting 38
shortcut for 117
using 44

turquoise line, histogram 55
TWAIN programs

definition 136
returning images to 61
scanning from 74
troubleshooting 103

24-bit color, definition 123
256 Color Palette 38
Type of file options 37
Typing cursor 121

U
underlined text, converting 76
Undo Editing Changes command

shortcuts 120
using 48

uniform scaling, definition 136
uninstalling software 113
unlocking scanner 90, 91
Unselect All 42

command 42
shortcuts 117

Update Scanner 36
USB

definition 136
User’s Manual, shortcut to 118

V
vector images, definition 136
View menu, shortcuts for 117
viewing

previewing scans 41

product tour 15
RGB values 55
Setup and Support Guide 113
slides 80

W
watermarks, removing 71
Web Palette

definition 136
output types 44

websites
optimizing scans for 64
output types for 44
placing images on 64
scanning items to 30

weight
paper specifications, ADF 17
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white areas, adjusting 51
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white images, troubleshooting 94
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wizard, HP Share-to-Web 30
word processing programs

formatting text in 100
resizing images in 45
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X
XPA (Negatives) command

shortcuts 116
using 82

XPA (optional transparency adapter)
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light source 80, 137
media sizes 18
models including 3
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scanner buttons, using with 104
slides, scanning 79
troubleshooting 98, 104
using 79

XPA (Slides) command
shortcuts 116

using 80

Z
Zoom In command

shortcuts 117, 119
using 43

Zoom Out command
shortcuts 117, 119
using 43

zooming
definition 23
in 43
menu shortcuts for 117
out 43
toolbar shortcuts for 119
viewing preview images 43
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